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Overview

1 Overview

1.1 What is Vision Air?

Vision Air is a modern, intuitive and easy-to-use software solution for rou-
tine Vis-NIR analysis and quality assurance. Vision Air is divided into 2
dedicated software parts.

While Vision Air Routine puts a focus on the needs of routine users,
Vision Air Manager provides administrative functions to meet the
requirements of laboratory managers and division managers.

Vision Air is available in 2 versions: Vision Air Local and Vision Air Net-
work. Vision Air Local includes all the necessary routine applications as
well as numerous management functions and enables the control of 1 Vis-
NIR spectrometer.

In contrast to Vision Air Local, Vision Air Network enables users to control
and configure any number of spectrometers. All data produced can be
saved automatically, both locally and globally.

Vision Air Local

Vision Air Local

. &
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Labsoratory mandger Routine Liar

In Vison Air Local, the program parts Vision Air Routine and Vision Air
Manager Local are both installed on 1 single computer.

This computer is directly connected to the instrument. The configuration
of the instrument, which includes information such as new operating pro-
cedures and new parameters, is done by the local administrator in Vision
Air Manager Local. All data, e.g. configurations, results and spectra is
stored on the local PC.

Acquisitions are performed in Vision Air Routine.
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Vision Air Network

Vision Air Server Vision Air Database

Vision Air Routine

Vision Air SQL database can be hosted

externally to the Vision Air Server. Default

SQL port is used. If using a remote database

you must:

a) create a SQL accout for Vision Air or

b) grant access to the machine account you
running Vision Air.

Vision Air Manager
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In Vision Air Network, the program parts Vision Air Routine and Vision Air
Manager Network are not installed on 1 single computer. Vision Air Rou-
tine is installed on the computer that is connected to the instrument. This
can also be a multiple setup with several instruments and the correspond-
ing computers. Vision Air Manager Network is installed on a computer
that is connected to the network, e.g. on the computer of a laboratory
manager.

For a network instrument, a network administrator configures the instru-
ment with Vision Air Manager. In this setup, all data is stored on the local
PC, but it is also transferred to the Vision Air server database during syn-

chronization.

Acquisitions are performed in Vision Air Routine on the computer that is
connected to the instrument.

Pharma versions of Vision Air Local and Vision Air Network

For working in regulated environments, both Vision Air versions can be
purchased as pharma versions. Additional features, such as user manage-
ment, audit trail and signing of objects are added to these versions.
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1.2 Product versions

The product is available in the following versions:

Table 1  Product versions

Art. no. Designation

6.6072.201 Vision Air 2.0

6.6072.202 Vision Air 2.0 Pharma

6.6072.203 Vision Air 2.0 Network Pharma

6.6072.204 Vision Air 2.0 Server

6.6072.205 Vision Air 2.0 Server Pharma

6.6072.206 Vision Air 2.0 Network

6.6072.207 Vision Air 2.0 Network Complete

6.6072.208 Vision Air 2.0 Complete

6.6072.209 Vision Air 2.0 Pharma Complete

6.6072.210 Vision Air 2.0 Pharma Network Complete
13 Symbols and conventions

The following formatting may appear in the documentation:

(5-12) Cross-reference to figure legend

The first number refers to the figure number. The
second number refers to the product part in the fig-
ure.

1 Instruction step

Numbers indicate the order of the instructions steps.

Method Names of parameters, menu items, tabs and dialogs

File » New Menu path

[Continue] Button or key
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2 Safety

2.1 Intended use

Metrohm products are used for the analysis and handling of chemicals.

Usage therefore requires the user to have basic knowledge and experience
in handling chemicals. Knowledge regarding the application of fire preven-
tion measures prescribed for laboratories is also mandatory.

Adherence to this technical documentation and compliance with the
maintenance specifications make up an important part of intended use.

Any utilization in excess of or deviating from the intended use is regarded
as misuse.

Specifications regarding the operating values and limit values of individual
products are contained in the "Technical specifications" section, if relevant.

Exceeding and/or not observing the mentioned limit values during opera-
tion puts people and components at risk. The manufacturer assumes no
liability for damage due to non-observance of these limit values.

The EU declaration of conformity loses its validity as soon as modifications
are carried out on the products and/or the components.

2.2 Responsibility of the operator

The operator must ensure that basic regulations on occupational safety
and accident prevention in chemical laboratories are observed. The opera-
tor has the following responsibilities:

= Instruct personnel in the safe handling of the product.

= Train personnel in the use of the product according to the user docu-
mentation (e.qg. install, operate, clean, eliminate faults).

= Train staff on basic occupational safety and accident prevention regula-
tions.

= Provide personal protective equipment (e.g. protective glasses, gloves).

= Provide suitable tools and equipment to carry out the work safely.

The product may be used only when it is in perfect condition. The follow-
ing measures are required to ensure the safe operation of the product:

= Check the condition of the product before use.
= Remedy defects and malfunctions immediately.
= Maintain and clean the product regularly.
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2.3 Requirements for operating personnel

Only qualified personnel may operate the product. Qualified personnel are
persons who meet the following requirements:

Basic regulations on occupational safety and accident prevention for
chemical laboratories are known and complied with.

Knowledge of handling hazardous chemicals is present. Personnel have
the ability to recognize and avoid potential dangers.

Knowledge regarding the application of fire prevention measures for
laboratories is available.

Safety-relevant information is communicated and understood. The per-
sonnel can operate the product safely.

The user documentation has been read and understood. The personnel
operate the product according to the instructions in the user documen-
tation.

2.4 Safety instructions

2.4.1 Danger from electrical potential

Contact with electrical potential can cause serious injuries or death. To
avoid danger from electrical potential, observe the following:

Operate the product only if it is in perfect condition. The housing must
also be intact.
Only use the product with the covers fitted. If covers are damaged or
missing, disconnect the product from the energy supply and contact
the regional Metrohm service representative.
Protect live components (e.g. power supply unit, power cord, connec-
tion sockets) against moisture.
Always have maintenance work and repairs on electrical components
carried out by a regional Metrohm service representative.
Disconnect the product from the energy supply immediately if at least
one of the following cases occurs:

— The housing is damaged or open.

— Live parts are damaged.

— Moisture penetrates.

2.4.2 Danger from biological and chemical hazardous substances

Contact with biological hazardous substances may cause poisoning from
toxins or infections from microorganisms. Contact with aggressive chemi-
cal substances may cause poisoning or chemical burns. To avoid danger

from biological or chemical hazardous substances, observe the following:
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Label the product according to regulations if it is used for substances
that have a potential for chemical hazards and are generally subject to
the Hazardous Substances Ordinance.
Wear personal protective equipment (e.g. protective glasses, gloves).
Use exhaust equipment when working with vaporizing hazardous sub-
stances.
Dispose of hazardous substances in accordance with regulations.
Clean and disinfect contaminated surfaces.
Only use detergents that do not cause any unwanted side reactions
with the materials to be cleaned.
Dispose of chemically contaminated materials (e.g. cleaning material) in
accordance with regulations.
Proceed as follows in case of a return shipment to Metrohm AG or a
regional Metrohm representative:

— Decontaminate the product or product component.

— Remove the labeling for hazardous substances.

— Create a declaration of decontamination and enclose it with the

product.

2.4.3 Danger from highly flammable substances

Using highly flammable substances or gases may cause fires or explosions.
To avoid danger from highly flammable substances, observe the following:

Avoid ignition sources.
Use protective grounding.
Use exhaust equipment.

24.4 Danger during transport of the product

Chemical or biological substances may be spilled during the transport of
the product. Parts of the product may fall down or may be damaged.
There is a risk of injury from chemical or biological substances and pieces
of broken glass. To ensure safe transport, observe the following:

Remove loose parts (e.g. sample racks, sample vessels, bottles) before
transport.

Remove liquids.

Lift and transport the product with both hands on the base plate.

Lift and transport heavy products only according to instructions.
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Safety

Design of warning messages

There are 4 hazard levels for warning messages. The following signal
words are used for classifying the hazard levels in warning messages:

DANGER indicates a hazardous situation which, if not avoided, will
result in serious injury or death.

WARNING indicates a hazardous situation which, if not avoided,
could result in serious injury or death.

CAUTION indicates a hazardous situation which, if not avoided, could
result in minor or moderate injury.

NOTICE indicates a hazardous situation which, if not avoided, could
result in property damage.

Warning messages differ in design (color and warning sign) depending on
the hazard level:

/\ DANGER
Type and source of danger

Consequences when not observing the notice: An irreversible injury
that may result in death is very probable.

= Measures to avoid the danger

/A WARNING
Type or source of danger

Consequences when not observing the notice: A serious injury that
may result in death is probable.

» Measures to avoid the danger

/\ CAUTION
Type or source of danger

Consequences when not observing the notice: A minor to moderate
injury is probable.
= Measures to avoid the danger
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2.6 Meaning of warning signs

This documentation uses the following warning signs:

Table 2 Warning sign according to 1SO 7010

Warning sign | Meaning

General warning sign

Warning of electrical voltage

Warning of hand injuries

Warning of sharp object

Warning of hot surface

Warning of biological hazard

Warning of toxic materials

Warning of flammable materials

Warning of corrosive substances

Warning of optical radiation

Warning of laser beams

> B BB BB

Depending on the intended use of the product, the corresponding warn-
ing sign stickers must be placed on the product.
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3 Vision Air - Functional description

3.1

3.1.1

Vision Air Manager Network

User interface

7= Vision Air Manager Network |

Wo¥H (visionain)
[ File View Report Help

i (% save % Revert

Instruments 0O | Name Chassis ID

91739555 Met... 36028822.. 91739555
91769767 Met... 36028861.. 91769767
DS 91737777 S... 36028831... 91737777

» B Metrohm Asia-Pacifique
» & Metrohm Europe
» BF Metrohm Germany

+ &P Metrohm HQ DS 91737849 .. 36028831... 91737849
+ & Metrohm UK DS 91753790 F... 36028844, 91753790
+ B Metrohm USA DS 91770113 5... 36028861... 91770113
» &P Metrom France XDS 3010-164.. 13490116 3010-1642
+ U Unassigned Instruments XDS 3010-164.. 12110186  3010-1646
XDS 3010-164.. 12110058  3010-1647
XDS 3010-172.. 13160056  3010-1722
XDS 3010-188.. 13430112 3010-1886
XD 3010-212.. 16250363  3010-2122
XDS 3010-232.. 18320677 3010-2325
XDS RLA 3010-., 13250015 3010-1763

[TB Instruments

Operating Procedures
Prediction models

NNt Prntes
@ Methods

1 User-Defined Fields

- Users

7 Configuration Change

® Surveillance

ﬁg Sample Lists

|Serial Number | Contact Name Contact Information | Instrument Settings

Operating Procedures | Licenses | Standardization

Registration
Name:

Chassis ID:

Registration date;
Installation date:

Serial number:

Contact:

Software package:

Deactivated:

Enable Surveillance:

Authenticated:

Descriptions

) Extended in:

Name

91739555 Metrohm ltalia
36028822804006819
07.03.2018 14:48:36
07.03.2018 14:09:07

91739555

Default software package <

strument information

| Value

Configuration master VisionAir

OS version
Time zone
IP address
CPU

Physical memory

System drive size

Total drive size

Microsoft Windows 10 Pro
{UTC+01:00) Amsterdam, Berlino, Berna, Roma, Stoccolma, Vienna
160.254.124.94

Intel(R) Core(TM) i7-3520M CPU @ 2.90GHz

160 GB

223168

223168

-

w

Navigation window

Options that enable the user to navigate
through Vision Air Manager (see "User inter-
face", chapter 3.1.1, page 9).

Toolbar

Data window

The information in this window varies
depending on the selection in the navigation
window, e.g. for the navigation window
Prediction models all available prediction
models are displayed.

Functional area
The work window can be divided into sev-
eral functional areas.

Structure window

Depending on the selection in the naviga-
tion window, the structure window shows a
tree of all created and registered networks
(with all instruments) or users.

Menu bar

Work window

The information in the work window varies
depending on the selection in the navigation
window and the structure window. The text
fields in the work window are either editable
(white) or read-only (grey).
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Navigation window

@ Instruments

’ Prediction models
-:'.-_ Parameter profiles

@ Methods

User- defirf2d fields

& Users

@ Surveillance

O O oo ~N 0O g bk WKN =

E@ Sample sets

—_—

Instruments
Registering instruments and editing instru-
ment properties.

Prediction models

Prediction models are algorithms that corre-
late NIR spectra to sample properties, e.g.
water concentration.

Methods

Methods describe the way how measure-
ments are conducted, e.g. information on
the sample vessel type used, number of rep-
etitions or sample temperature during an
analysis.

@l Operating procedures

c Configuration change

Operating procedures

Operating procedures are key elements in
Vision Air to conduct measurements. An
operating procedure consists of 1 or several
prediction models, a method as well as
optional user-defined fields. Operating pro-
cedures are selectable in Vision Air Routine
to conduct analysis.

Parameter profiles

Parameter profiles define the parameter to
be analyzed in accordance with the linked
prediction model, e.g. a parameter profile
for a prediction model to quantify water
content is water in %.

User-defined fields

User-defined fields allow users to create cus-
tomized sample registration fields. During
routine analysis, a user may need to enter
additional information, e.g. the batch num-
ber.
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7 Users 8 Configuration change
In the Users section the user permissions for The Configuration Change section lists all
the Vision Air Manager Nework are defined. existing configuration changes. A change in

the configuration needs to be uploaded to
the individual clients. The individual clients
are also managed in this section.

9 Surveillance 10 Sample lists
Overview of all measurements, events and Sample lists are used to organize collected
instrument tests. spectra and results. Sample lists are also

used to conduct slope corrections and bias
corrections.

3.1.2 Network group settings
The structure window displays the available networks, the instrument
types and the instrument groups for all sections except the Users section.

To define network properties, right-click on a network and select Proper-
ties.

The network properties contain the following work tabs:

2 Network Properties

Surveillance | Report Templates = Standardization Groups | Data Cleanup | Security
General network settings
Marne: Cemao Metwork
Description: Demo Metwerk for Simulater DS and for use of Pre-Calibrations
Summary

The network name and a description of the network can be entered in the
Summary tab.

Surveillance

The calculation intervals (Maximum/Minimum) can be changed in the Sur-
veillance tab. Calculation intervals handle the frequency of updating
automatic flags in Surveillance. Automatic calculation takes place when
the server receives new data from the instrument according to the follow-
ing examples:

=  Minimum intervals [minutes]: If set to 5, the server will not recalcu-
late flags in spite of the fact that the instrument uploads lots of sam-
ples, logs, etc. It will delay the recalculation 5 minutes.

= Maximum intervals [minutes]: If set to 15, even if no data was
received from the instrument it will recalculate after 15 minutes.
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Report Templates

On this tab customer designed report templates can be linked to the net-
work. The new report templates are accessible only in the Veision Air
Manager Network but not in the Vision Air Routine (client).

When a template has been imported or linked, a report based on the tem-
plate can be generated in the Report menu.

Press [Remove] to remove a template.

Press [Export...] to save the template file and to use it on other networks.

Standardization Groups
This functionality is not used with the current Metrohm product line.

For DS2500 instruments, standardization gruops can be defined to define
a set of DS2500 instruments that use the same standardization file. Use
standardization files to apply instrument adjustments to prediction models
that were developed in other softwares. Prediction models that can be
used in more than 1 software are called combined prediction models.
When a standardization file is imported, it is linked to the prediction
model of the instrument.

Data Cleanup

Under this tab the user can enable data cleanup and set the interval
(months) between automatic deletion of old samples. The default value is
36 months. Date and time of the last cleanup is stated at the bottom of
the dialog window.

To delete all samples from the current date, press [Cleanup now].

ﬂ Samples included in static sample list and samples with reference
values are not deleted.

Security

On the Security tab Vision Air has support for Authenticated mode for
Vision Air Manager. This means that prediction models on the individual
instrument will become unusable unless the instrument is connected with
the Vision Air Server within a given time frame. It is based on time limited
licenses for authenticated prediction models. This means that the predic-
tion will no longer work if these licenses are not renewed by the Vision Air
Server in due time.

Authentication model level:

= The use of authenticated mode is optional and off by default.
» An entire Vision Air Network or individual instrument groups in the net-
work can be authenticated.
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If an authenticated prediction model fails on Vision Air because the instru-
ment has not been in contact with the Vision Air Server within the grace
period (default setting is 14 days), then the following message appears:

Authenticated prediction model: <PM> has not been authentica-

ted by the Vision Air Server within the grace period.

Check that instrument is connected to the Vision Air Server and

contact your Network Manager if the problem persists.

Instrument group settings

To define instrument group settings, right-click on an instrument group

and select Properties.

Ses| Vision Air Manager Network I

WiSH (visionain
File View Report Help
|:| Save 9 Revert

Instruments £ | Mame Chassis I3 Serial
+ & Dema Network | DS Finnland IAN28844774997979 91753
» BF Metrohm Argen New netnork 7
N E Metrohm Asia-P Assign instrument types... 7

Import licenses
E Metrohm Austri b

b E Metrohm Brasil

0
Import instrument group configuration

N E Metrohrn Europ Export parameters and operating procedures for translation
b E Metrohm Germ Import parameter and operating procedure translations
» & Metrohm HQ. Properties ~ "

3 ﬂ Metrohm Israel
v &F Metrohm ltalia

The instrument group properties contain the following work tabs:

Instrument Settings ~ Operating Procedures | Parameters | Surveillance Limits | E-mail Reporting

Instrument Group Properties o

General information

Name: |Preca|\bratian Group
Instrument type: | MIRS D52500

Authenticated:

Software package: Mo software package selected

Description:

Summary
The Summary tab displays the following information about the group:

= Name
Name of the instrument group.
= Instrument Type
This field is read-only and cannot be changed.

13
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» Authenticated
If this option is activated, then DS2500 instruments in an instrument
group require regular connection with the Vision Air Server to use the
provided operating procedures.
In the work tab Summary, this option is read-only. Activate or deacti-
vate Authentication under Network Properties on the work tab
Security (see "Security", page 12).

» Software Package
Only 1 default software package is available for Vision Air.

» Description
Optional description that can be added by the user.

Instrument Settings

Details on the instrument settings are displayed under the Instrument
settings tab. Some settings are read-only.

Some instrument settings, e.g. Instrument diagnostics can only be
modified for a complete instrument group. Instrument settings that can be
set for single instruments are changed in the work tab Instrument Set-
tings.

Advanced settings can be displayed by activating the advanced view under
View » Options » Display advanced settings. Advanced settings are
only active for the current session. After a restart of Vision Air Manager,
the display is reverted o the basic view. Advanced settings should only be
modified by Metrohm representatives or after consultation with a Met-
rohm representative.

If different XDS modules have been used with Vision Air in the past, the
individual modules are selectable in the configuration drop-down list.

Configuration:  XD5 MasterLab (reflectance) -

XDS MasterLab (reflectance)

XDS Masterlab (transmission)

XDS MultiVial

XDS OptiProbe (transmission)

XD5 Rapid Ligquid Analyzer

XD5 Rapid Solids Analyzer w. spot size
XDS SmartProbe

b | Extensions

The following instrument settings are available:
Automatic synchronisation

Settings for automatic synchronisation with the Vision Air Server. Define
the interval to check for new updates. Define whether data should be
uploaded automatically. If you enable this option, define an interval for
the upload of data. Define a delay for automatic sample upload.

Check-samples (only available for DS2500 instruments)

Settings to define the behavior when using operating procedures with
check samples.
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If Check-sample reminders enabled is checked, the user is reminded
to analyze a check sample in the given interval (default setting: every 48
hours). The user has a grace period in which a successful check sample
should be analyzed (default setting: 2 hours). If the user fails to analyze a
successful check sample, the normal samples are marked with a warning if
Mark samples after unsuccessful check-sample is checked.

Check samples are physical samples that can be considered stable over
some period of time. They are used as an additional verification of the
instrument performance (see "Check samples”, chapter 3.3.4, page 67).

Common hardware selftest limits (only available for DS2500
instruments)

Read-only view for self test limits. These parameters are defined within the
firmware of the instrument.

Data cleanup

Settings to define if and when normal samples or check samples should
be automatically deleted.

Diagnostic test reminders

Settings to enable an automatic reminder in Vision Air Routine to conduct
a low-flux test, a wavelength certification or a photometric test. The fol-
lowing options are available:

= Enabled: If active, the user is reminded to perform the instrument diag-
nostic test.

= Interval: Frequency of instrument diagnostic tests (in days).

= Grace period: Time that remains until the user has to perform the
instrument diagnostic test (in hours).

= Action on expiration or failure: Definition of what happens if no test
was performed after the defined time. This ensures that data is only
measured with properly working instruments. The user can either disa-
ble the measurement completely or flag the measured samples with an
error.

Instrument diagnostics

Settings for the instrument diagnostic test that is conducted in Vision Air
Routine. If the automatic instrument diagnostic test is deactivated, then
the automatic test does only run if the last conducted test failed, was can-
celed or was never performed.

If the instrument diagnostic test reminder is enabled, it reminds the user
to perform an instrument diagnostic test in the given interval (default set-
ting: every 8 days). The user has a grace period to perform a successful
test (default setting: 2 hours). If the user fails to perform a successful test,
the normal samples are marked with a warning or the measurement is dis-
abled. This depends on the selected option in Vision Air Manager.
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Run start-up test.

= XDS instruments:
Always: The start-up test runs on every startup of Vision Air Routine.
After unsuccessful diagnostic test: The start-up test only runs if a diag-
nostic test failed.

= DS2500 instruments:
After unsuccessful diagnostic test or instrument restart: The start-up
test only runs if a diagnostic test failed or the instrument has been
restarted.
After unsuccessful diagnostic test: The start-up test only runs if a diag-
nostic test failed.

Report templates

Section for the import of report templates that are available in the Tools
section in Vision Air Routine. Only sample-related templates can be impor-
ted in this section (the same restrictions apply as for report templates that
are imported in the automatic export and print format sections).

Operating procedures
The Operating procedures tab lists the linked operating procedures.

Operating procedures can be added and removed ([Add...] / [Remove])
by the user. By clicking [Applyl, changes are applied immediately (win-
dow is not closed). By clicking [OK], changes are applied immediately and
the window is closed.

Parameters

The order of parameters (Parameter display order) is defined in Param-
eter profiles and is global for a given network. Under the Parameters
tab it is also possible to define a display order for an instrument group. l.e.
to accommodate different customers that participate in a network.

Surveillance Limits

The surveillance limits are settings that define when a flag in the surveil-
lance section is displayed. Parameters regarding the following topics can
be set:

= Connectivity

— Ping limit

— Download limit

— Upload limit
= Analysis results

— Outlier limit

— Product limits = Operating procedure limits
= General events

— Error limits

— Warning event limits
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E-mail Reporting

In the upper section of this tab the user can select the settings for the
automatic e-mail report. The e-mail report is sent to the instrument con-
tact persons. Select a report interval (Never/Weekly/Monthly) and a
report (Instrument status/Flags log).

The lower section of this tab lists e-mail alert recipients. An e-mail alert is
sent to the recipients when a surveillance limit has reached a warning/
error limit. Click [Add...] or [Remove] to add/remove recipients from the
list.

Instrument Search

In the Instruments and Surveillance area it is possible to search for spe-
cific instruments. Clicking on the magnifier icon will bring up the instru-
ment search view. Here it is possible to search by using a combination of
instrument type, name and serial number.

Instruments section

Contact Information | Instrument Settings | Operating Procedures | Licenses | Standardization

Registration

Name: DS Finnland
Chassis ID: 36028844274992929
Registration date: | 13.09.2018 14:15:35
Installation date: | 13.09.2018 13:53:04
Serial numben 91753790

Contact:

Software package:  Default software package -

Deactivated:

Enable Surveillance:

Description:

NIRS D52500

Microsoft Windows 10 Home

(UTC~01:00} Sarajevo, Skopje, Warszawa, Zagreb
169.254.23.230

Intel(R) Celeron(R} CPU N2840 @ 2.16GHz
Physical memory  4.0GB

102.1GB

1006 GB

All instrument related settings are made in the Instruments section in
Vision Air Manager.

The Instruments section contains the following work window tabs:

Summary

The Summary tab contains the general information on the instrument.
Here, the instrument name can be defined and a description of the instru-
ment can be added. The following instrument specific information is dis-
played as read-only:

Chassis ID

Specific instrument ID.
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Registration date

Date of the registration of the instrument with the server. In Vision Air
Network, the registration date and the installation date may differ.

Installation date

Date of the first connection of the instrument with Vision Air Routine.
Serial number

Serial number of the monochromator.

Contact

The contact person is set in the Contact information tab.
Software package

Only 1 default software package is available for Vision Air.
Deactivated

The user can deactivate the current instrument. Deactivate an instrument
to remove the instrument from the Vision Air Manager Network.

Enable Surveillance
In the Instruments section, the setting Enable surveillance is read-only.

In the Surveillance section, the user can check/uncheck the check box
Enable surveillance. After disabling, the instrument is not flagged any-
more, for example after a failed instrument diagnostic test.

Contact information

The Contact information functional area contains information about the
person who is responsible for the instrument.

Contact persons are created in the Users section. To select a contact, click
on [Pick another contact], select a contact in the pop-up window and
press [OK].

In the Instrument location functional area, it is possible to enter the
GPS location and time zone of the instrument:
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Instrument settings

Setting Groups

Automatic export and print formats
Automatic synchronisation
Check-samples

Data cleanup

Diagnostic test reminders
Instrument diagnostics

Local Vision Air settings

Report templates

User-defined field values

Some settings are read-only. These settings can only be modified for the
complete instrument group (see "Instrument group settings”, chapter
3.1.3, page 13).

Details on the instrument settings are displayed under the Instrument
settings tab. Settings in this work tab are read-only. Modifications of the
settings are done in the instrument group setting area (see "Instrument
group settings”, chapter 3.1.3, page 13).

If different XDS modules have been connected with Vision Air Server in
the past, the individual modules are selectable in the configuration drop-
down list.

Configuration:  XD5 MasterLab (reflectance) -

XDS MasterLab (reflectance)

XDS Masterlab (transmission)

XDS MultiVial

XDS OptiProbe (transmission)

XD5 Rapid Ligquid Analyzer

XD5 Rapid Solids Analyzer w. spot size
XDS SmartProbe

| > | Extensions

The following instrument settings are available:
Automatic export and print formats

Settings to define which templates should be printed automatically and
which templates should be created automatically after a measurement in
Vision Air Routine. Set the storage location and the final activation of this
procedure in Vision Air Routine under Tools » Settings » Export or
print.

You can import additional report templates for automatic export options
with the [Import] button. The newly imported reports are available for
selection for automatic export. Only sample related templates can be
imported in this section.

Check-samples (only available for DS2500 instruments)
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Settings to define the behavior when using operating procedures with
check samples.

If Check-sample reminders enabled is activated, the user is reminded
to analyze a check sample in the given interval (default setting: every 48
hours). The user has a grace period in which a successful check sample
should be analyzed (default setting: 2 hours). If the user fails to analyze a
successful check sample, the normal samples are marked with a warning if
Mark samples after unsuccessful check-sample is activated.

Check samples are physical samples that can be considered stable over
some period of time. They are used as an additional verification of the
instrument performance self test (see "Check samples”, chapter 3.3.4,
page 67).

Common hardware selftest limits (only available for DS2500
instruments)

Read-only view for self test limits. These parameters are defined within the
firmware of the instrument.

Data cleanup

Settings to define if and when normal samples or check samples should
be automatically deleted.

Diagnostic test limits (only available for DS2500 Solid Analyzer
and XDS instruments)

In this setting, a Metrohm representative can add different configurations
for the test limits.

Diagnostic test parameters (only available for DS2500 Solid Ana-
lyzer and XDS instruments)

Settings where the number of test runs for low-flux tests and for wave-
length certification tests is defined. Reference correction files are stored on
the USB flash drive that is delivered with the individual standard sets, e.g.
standard set 6.7450.010. These reference correction files can be stored
permanently in Vision Air Manager. With this, the user does not need to
insert the USB flash drive and select the file during diagnostic tests. The
validity of files and standards is typically 1 year and can be renewed by a
recertification. Contact your local Metrohm agency for details regarding a
recertification.

The following options are available:

= Number of reference subscans: Average of subscans (read-only).

» Number of WSR (wavelength standard reflectance) subscans: Average
of WSR subscans (read-only).

= Number of low-flux test runs: Average of low-flux test runs.

= Number of wavelength certification test runs.
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= Show only valid standard sets in Vision Air Routine: Standards have a
due date. If the check box is activated, only standards where the due
date is OK are displayed.

= External references: Add additional reference files here.

Diagnostic test reminders (only available for DS2500 Solid Ana-
lyzer and XDS instruments)

Settings to enable an automatic reminder in Vision Air Routine to conduct
a low-flux test, a wavelength certification or a photometric test. The fol-
lowing options are available:

= Enabled: If active, the user is reminded to perform the instrument diag-
nostic test.

= Interval: Frequency of instrument diagnostic tests (in days).

= Grace period: Time that remains until the user has to perform the
instrument diagnostic test (in hours).

= Action on expiration or failure: Definition of what happens if no test
was performed after the defined time. This ensures that data is only
measured with properly working instruments. The user can either disa-
ble the measurement completely or flag the measured samples with an
error.

Flash settings (only available for DS2500 instruments)

Low level settings that can be helpful for support activities. Flash settings
are read-only. These settings are defined within the firmware of the instru-
ment.

Hardware self test limits (only available for DS2500 instruments)

Read-only view for instrument specific settings. The settings are defined
within the firmware of the instrument.

Hardware sensor limits (only available for DS2500 instruments)

Read-only view for instrument specific settings. The settings are defined
within the firmware of the instrument. The current DS2500 product line
does not use the settings.

Instrument calibration settings (only available for DS2500 Solid
Analyzer)

Read-only view for instrument specific settings. The settings are defined
within the firmware of the instrument.

Instrument diagnostics

Settings for the instrument diagnostic test that is conducted in Vision Air
Routine. If the automatic instrument diagnostic test is deactivated, then
the automatic test does only run if the last conducted test failed, was can-
celed or was never performed.
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If the instrument diagnostic test reminder is enabled, it reminds the user
to perform an instrument diagnostic test in the given interval (default set-
ting: every 8 days). The user has a grace period to perform a successful
test (default setting: 2 hours). If the user fails to perform a successful test,
the normal samples are marked with a warning or the measurement is dis-
abled. This depends on the selected option in Vision Air Manager.

Run start-up test.

= XDS instruments:
Always: The start-up test runs on every startup of Vision Air Routine.
After unsuccessful diagnostic test: The start-up test only runs if a diag-
nostic test failed.

= DS2500 instruments:
After unsuccessful diagnostic test or instrument restart: The start-up
test only runs if a diagnostic test failed or the instrument has been
restarted.
After unsuccessful diagnostic test: The start-up test only runs if a diag-
nostic test failed.

Local Vision Air settings

Read-only view for file storage options in Vision Air Routine. Define the
settings directly in Vision Air Routine.

Report templates

Section for the import of report templates that are available in the Tools
section in Vision Air Routine. Only sample-related templates can be impor-
ted in this section (the same restrictions apply as for report templates that
are imported in the automatic export and print format sections).

Stability test limits (PbS, Si or InGaAs)
Noise test limits for the individual detectors.

= Drift noise limit
= Random noise limit

Do not change factory settings yourself. Ask a Metrohm representative for
assistance.

Performance test parameters (only available for XDS instruments)

Settings for the total amount of test runs, noise (reference) and number of
wavelength (WSR) scans that are performed during the instrument diag-
nostic test.

Stability test parameters

Settings for duration and acceptance limits for stability tests that are con-
ducted during the instrument diagnostic test. The following options are
available:
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= Maximum test time: Maximum run time for the stability test. The maxi-
mum test time defines the maximal testing time for both stability tests:
The lamp temperature stability test and the stability test (noise values).

= Number of reference subscans: Average of subscans.

= Number of scans: Number of measurements.

= Wait for a stable bias timeout (only available for XDS instruments):
Noise test.

The tests can end before the total test time is reached if the test values,
e.g. noise values, are below the set acceptance criteria. The maximum test
time includes the test time for lamp stabilization and for noise bias.

With the DS2500 series, the number of scans and subscans can be
defined.

Subscan settings (only available for DS2500 instruments)

Read-only view for subscan settings. The settings are defined within the
firmware of the instrument.

User-defined field values

Handling of values in user-defined fields. If the check box is activated, the
values entered by the user are stored. Set the period how long a user-
defined value is stored in the input field during sample registration.

Wavelength test limits (PbS, Si or InGaAs)

Wavelength test limits for the individual detectors. For the DS2500 series,
the bandwidth limits can also be set. The following options are available:

= Bandwidth accuracy limit

= Bandwidth repeatability limit
= Wavelength accuracy limit

= Wavelength repeatability limit

Do not change factory settings yourself. Ask a Metrohm representative for
assistance.

Wavelength test parameters (only available for DS2500 instru-
ments)

Settings for the instrument diagnostic test. The following options are avail-
able:

= Number of reference scans: Average of scans.

= Number of test runs: Number of measurements.

= Number of WSR (wavelength standard reflectance) subscans: Average
of WSR scans.

Operating procedures

The working tab Operating Procedures displays operating procedures
that are linked to the selected instrument.
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Licenses
In this section, licenses for the instrument can be imported and deleted.

Licenses can be imported to enable routine measurement and to activate
secured prediction models that are provided with Metrohm pre-calibra-
tions. Licenses, except demo licenses, are always instrument (monochro-
mator) specific.

Standardization (only available for DS2500 instruments)

By using a standardization file, it is possible to apply instrument adjust-
ments to prediction models that were developed in other softwares. Pre-
diction models that can be used in more than 1 software are called com-
bined prediction models. When a standardization file is imported, it is
linked to the prediction model of the instrument.

Click on [New group] if multiple instruments should use the same stand-
ardization. Delete groups by clicking [Delete group].

Click on [Link file] to browse and link a prediction model to a standardi-
zation file (*.std).

Remove a linked file by selecting a file under the standardization tab and
click on [Remove file].

This functionality is not used with the current Metrohm product line.

3.15 Operating procedures section

|| summary NEECHISHYCENEEN Prediction models | Methods | User-Defined Fields | Limits

Linked Instrument Groups: Allow linking to individual instruments

@ Instrument Group 4| Description Add...

> * |Precalibration Group

Instrument Serial Number

Remove

DSFinnland 81753780
DS Iran 91737849
DS South Africa 91737777
DS Valentina 91770112

All settings related to operating procedures are set in the Operating pro-
cedures section.

Prediction models, methods and user-defined fields are linked with the
respective operating procedure in the Operating procedures section.

Lower and upper warning limits and intervention limits are defined in the
Operating procedures section.

The structure window lists all available operating procedures and operat-
ing procedure groups (&) of the instrument.

Operating procedure groups can be created by right-clicking on the struc-
ture window and selecting New operating procedure group. Operat-
ing procedures can be assigned to operating procedure groups by right-
clicking on the individual operating procedure and selecting Move to
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operating procedure group. Operating procedure groups allow to
structure operating procedures.

The Operating procedures section contains the following work window
tabs:

Summary

The Summary tab shows the following general information on the high-
lighted operating procedure in the structure window.

= The name of the selected operating procedure.

» The operating procedure code. It must be defined to export operating
procedures via File » Export » Configuration. \We recommend
naming the code identically to the operating procedure.

= The sample type. It defines the kind of sample to be measured. The fol-
lowing sample types are available.

— Normal: Standard samples for quality control.

— Check sample (only available for DS2500 instruments): Physical
samples that can be considered stable over a period of time.
Check samples are used as an additional verification of the
instrument performance (see "Check samples", chapter 3.3.4,
page 67).

— Standardization (only available for DS2500 instruments): Stand-
ardization samples are used for instrument calibration. Currently,
Vision Air does not support this functionality.

Select the appropriate operating procedure type from the Type drop-
down list.

The selected type determines the list of icons. Any icon can be selected if
the Show all icons check box is activated.

An icon can be selected with the Icon drop-down list. The selected icons
are displayed in Vision Air Routine.

By default, all new operating procedures are active. The check box Active
is activated. When the user deactivates an operating procedure, the oper-
ating procedure is no longer displayed in Vision Air Routine.

Instrument groups

M Prediction models | Methods | User-Defined Fields | Limits

Linked Instrument Graups: Allow linking to individual instruments

Instrument Group | Description Add..
4 Group

Remove

In this working tab the selected operating procedure can be added to the
individual instrument groups. If the checkbox Allow linking to individ-
ual instruments is active, then the operating procedure can be linked to
an individual instrument. After activating the checkbox, the instrument
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groups are displayed as drop-down lists. The drop-down lists show all
available instruments in a group. To activate individual selection, right-click
on a group and select Link current Operating Procedure to INDIVID-
UAL instruments in group.

um Prediction models | Methods  User-Defined Fields | Limits

Linked Instrument Groups: Allow linking to individual instruments

@ Instrument Group 4| Description Add...

LR A + ] precaibration Groufg
p Remove

Link current Operating Procedure to ALL instruments in group
Instrument 1
[ Link current t Operating Procedure to INDIVIDUAL in group |

DSFinnland 91
DS Iran o
DS South Africa 91
DS Valentina 91 Select all instruments
- Deselect all instruments

Add...

Remove

Prediction models

Prediction models can be linked to operating procedures. The hierarchical
prediction model view allows to link prediction models with products or
other prediction models.

Summary MEEelilONGEEE Methods  User-defined fields  Limits

Linked Prediction Models: Prediction model options:  Hierarchical prediction models «
) 5 ; o . . Flat list of prediction models
hd % Simulator Identification Polyol v.1.0.0.0 [Vision Identification] e e
» 0: Polyol

1: Zn-Stearate
-1: Undefined

In the displayed example, on the first level, a sample identification is con-
ducted. On the second level, if identified as a polyol, Vision Air conducts a
quantification of the hydroxyl number and the moisture.

- ﬁ Simulator Identification Polyol v.1.0.0.0 [Vision Identification]
v 0: Polyol
gT. Simulator Hydroxyl Number v.1.0.0.0 [Vision MLR]
&L Simulator Moisture v.1.0.0.0 [Vision MLR]
1: Zn-Stearate
-1: Undefined

In order to link individual prediction models or operating procedures,
select the prediction model or operating procedure you want to link with
another prediction model. Click on [Add] or right-click on the prediction
model or operating procedure. This function enables the configuration of
workflows, e.g. a quantification is only performed in Vision Air Routine if
the product has been identified correctly.

Methods

Methods can be linked to operating procedures. Multiple methods can
only be linked with 1 operating procedure when using the XDS analyzer
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series. We do not recommend using multiple methods within the same
operating procedure in Vision Air Local.

User-defined fields

User-defined fields can be linked to operating procedures.

Limits

Warning limits and intervention limits can be set for operating procedures.

The limits can be set for each instrument individually by activating the
checkbox Allow instrument specific Operating Procedure limits.

There are 3 types of operating procedure limits:

= Absolute
= Relative
« Differential

The figure below illustrates the difference between the types:
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Table 3

1 | Absolute upper warning limit =15

Relative upper warning limit = 50%

Differential upper warning limit =5

2
3
4 | Upper intervention
5

Upper warning
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6 | Target

7 | Lower warning

8 Lower intervention

The target value is always absolute. The differential limit is essentially a dis-
tance between corresponding absolute limit and target.

= Absolute Upper Action = Target + Differential Upper Action
= Absolute Upper Warning = Target + Differential Upper Warning
» Absolute Lower Action = Target - Differential Lower Action
= Absolute Lower Warning = Target - Differential Lower Warning

A target value needs to be defined for a relative limit. When using check
samples and a check sample operating procedure, the target value is
defined by the value of the check sample operating procedure (see "Check
samples", chapter 3.3.4, page 67).

Example of relative limits:

Prediction Model  Parameter Profile Type Lower Action Lower Warning  Target Upper Warning  Upper Action
lacfrue ,Ladme Content | Retative Bl 900 6,00 1000 sm] 900

« Lower Action Level: 10-9 % = 10-(0.09x10) = 9.1

= Lower Warning Level: 10-6 % = 10-(0.06x10) =9.4

= Upper Warning Level: 1046 % = 10+(0.06x10) = 10.6
= Upper Action Level: 10+9 % = 10+(0.09x10) = 10.9

Limits of prediction models can be imported/exported as .csv files. High-
light a prediction model and press [Import] and [Export] from the File
menu to open the browser window.

3.1.6 Prediction models section

Prediction models are algorithms correlating NIR spectra to properties of
the sample, e.g. water concentration.
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Each prediction model is linked to 1 parameter profile.

4 different prediction model types can be created by right-clicking on the
data window screen.

= Imported prediction models
Imported prediction models are standard prediction models for routine
analysis that were created in Vision, PLS_Toolbox or The Unscrambler.

» Calculated prediction models
Calculated prediction models allow automatic post-processing of val-
ues that were evaluated with imported prediction models. Calculated
prediction models can also use values from user-defined prediction
models (see "Calculated prediction models”, chapter 3.3.6, page 70).

» User-defined prediction models
User-defined prediction models are values that routine users enter dur-
ing measurements. These values can be further used with calculated
prediction models. A typical user-defined prediction model is a temper-
ature value (see "User-defined prediction model ", chapter 3.3.7, page
75).

= Placeholder prediction models
Placeholder prediction models are only used to collect data and are
therefore not predicting any result.

The Prediction models section contains the following work window
tabs.

The tabs that are displayed in the Prediction models section depend on
the type of selected prediction model.

Summary

The Summary tab contains general information and settings of the predic-
tion models.

The General information field shows the following parameters.

= Name of the selected prediction model.

» The standardization group setting is only available for imported predic-
tion models and user-defined prediction models.
A standardization group is a logical group of instruments with linked
standardization files. The standardization group defines a standardiza-
tion file for each instrument that belongs to the group. This function is
not needed for the current Metrohm product line.

= The wavelength range of the system is displayed for imported quantita-
tive prediction models, e.g. 400 - 2499.5 nm for a reflection XDS
instrument or DS2500 instrument.

= The version number is automatically updated when an existing predic-
tion model is imported again and updated.

= The part number displays a serial number for protected prediction
models.
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» The imported and updated dates display the date when the prediction
model was imported and updated. If no update has been conducted
yet, the imported and updated date are identical.

» Method displays which algorithm was used to create the prediction
model.

= Engine displays which software was used to create the prediction
model.

The Linked parameter profiles area shows a list of the linked parame-
ter profiles.

The link to a parameter can be changed by clicking on [Change...] and
selecting another parameter profile in the pop-up window.

When the check box in the column Hidden is checked, Vision Air Routine
does not show the parameter information.

Click on Parameter unit to display a list of all available Vision Air units.

In order to select a new unit, an appropriate parameter profile that uses
the new unit must be selected by clicking on [Change]. Changing the unit
does not affect prediction values or samples that were already analyzed
with this parameter (unit is just a parameter attribute displayed with the
prediction value).

Parameter settings
Quantitative prediction models

For quantitative prediction models, the Parameter settings work section
allows to define which data points should be taken into account for slope
corrections and intercept corrections.

The moment when a slope correction and intercept correction should be
applied can be defined.

To conduct a slope correction or intercept correction, create a sample list
in the Sample lists section. Perform the correction in the Sample lists
section or in the Prediction models section in the Slope / Intercept tab
(see "Slope/intercept calculations", chapter 3.3.8, page 75).

Identification prediction models

A list of all products and the according parameter output is displayed in
the Output values option. The output can be renamed in the section.

Define the warning threshold in Vision Air Routine in Qualification
options. Here, you can also define whether the actual distance of the
sample is displayed or not.

Qualification prediction models

Define the parameter output in the Output values option. Define the
parameter output for the 3 categories good, warning and bad. Select the
warning threshold in Qualification options.
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Links

The link section provides an overview over all operating procedures that
use the selected prediction model. If the selected prediction model has
been copied, a list of all existing copies can be displayed.

Licenses

The Licenses work tab is available only for prediction models that require
a license. In the Licenses work tab all instruments that use the prediction
model are displayed. The tab shows whether a valid license is present or
not.

Summary | Parameter Settings | Links [ESS= Moisture compensation | Slope/intercept

o Instrument | Issuer  Expiry |
L XDS - Switzerland (SN 3010-2122)
XDS - Switzerland (SN: 3010-1886) VisionAirLicenseCertificate
XDS - South Africa (SN: 3010-1646) VisionAirLicenseCertificate
XD5 - Portugal (SN: 3010-1647) VisionAirLicenseCertificate

Moisture compensation

Activate or deactivate moisture compensation. This functionality is not
used with the current Metrohm product line.

Slope/intercept

Apply a slope and/or intercept correction to a quantitative prediction
model (see "Slope/intercept calculations", chapter 3.3.8, page 75).

Parameter profiles section

mERRRRRRRRRARARA

Parameter profiles define the parameter to be analyzed in accordance with
the linked prediction model, e.g. a parameter profile for a prediction
model to quantify water content is water in %.

The Parameter profiles section contains the following work window
tab:
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Summary

The summary tab contains general information and settings of the param-
eter profiles. The General information field shows the following param-
eters:

32

The name is displayed in Vision Air Manager Network.
The short name is displayed during result display in Vision Air Routine.
The parameter code is used to import reference values with .csv files in
Vision Air Routine (see "Importing reference values with a .csv file",
chapter 3.3.3, page 67).
The data type defines to which kind of prediction model the parameter
profile can be linked.
— Parameter profiles for identification and qualification prediction
models are defined by selecting the String data type.
— Parameter profiles for quantification prediction models are
defined by selecting the Double data type.

When selecting the data type Double, the unit can be selected. The
selected unit is displayed in the result view in Vision Air Routine. When
linking prediction models to parameter profiles in the Prediction
models section, only parameter profiles that fit to the selected unit of
the prediction model are displayed.

Placeholder prediction models have been defined to be linked to
parameter profiles with the Double data type. Placeholder prediction
models are only used to collect data and are therefore not predicting
any result.

By activating the check box Force negative to zero, users see ‘0’
when a result value is negative.

The Display order field has the last generated display order number
plus 1 by default. The counting starts with 100. Avoid generating 2
profiles with the same display order number. This setting determines
the order in which parameters are displayed in the Samples view in
the Surveillance section and in the Result view in Vision Air Routine.
The Report sort order setting determines how parameter columns
are ordered in the sample detail and sample list reports. The counting
starts with 100.
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Methods section

Methods describe the way a measurement is conducted, e.g. number of
repetitions or sample temperature during an analysis.

In Vision Air Manager for XDS, a method can be created for the different
available modules.

In Vision Air Manager for DS2500, only methods for DS2500 instruments
can be created.

Methods are added by right-clicking on the ® icon of the individual mod-
ule or instrument and selecting [Add method].

The Methods tab contains the following work window tabs:

Summary

» Definition of the method name.

= Definition of the sample vessel in the drop-down menu sample han-
dling.

Settings

The Setting tab contains detailed settings of the method with respect to

the selected sample vessel.

The following settings are available.
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Analysis

The user can define whether the instrument should perform an autoli-
nearization (x-axis correction) before each scan. Metrohm suggests to
keep this setting active.

The number of reference subscans can be defined. The default value is
32.

The frequency of reference scans can be defined under Run reference
scan after warm-up. For XDS instruments a value in minutes can be
entered. The default value is 0. O represents a reference scan before
each measurement. For DS2500 instruments, 4 options are available.
Warm-up time refers to the time period when Vision Air Routine is first
started. The user can modify the length of the warm-up time (only
available for XDS instruments). The default value is 120 minutes. Dur-
ing warm-up time, a reference scan is conducted before each measure-
ment by default.

Automatic start control (only available for DS2500 Liquid Analyzer)

If the checkbox Automatic start is checked, the measurement starts
automatically after closing the lid of the DS2500 Liquid Analyzer.
Display options

The user can define which information is displayed about the sample
vessel and outliers during a routine analysis. Comment fields can be
activated or deactivated during sample registration. Comment fields
can be set as mandatory.

Liquid setup (only available for DS2500 Liquid Analyzer)

If the checkbox Check sample vessel type is enabled, the system
checks whether the inserted sample vessel matches with the sample
vessel defined in the method.

Defines options regarding the temperature of the sample holder and
the sample (see "Heating and cooling the sample", page 81).

Defines whether there is a delay before a scan starts and the length of
the delay. With a delay before a scan, you can ensure that the sample
has the same temperature as the sample holder.

lllumination (only available for XDS instruments)

Setting to adjust the spot size.

Repetition

Definition of the number of subscans per measurement. The default
value is 32. For a DS2500 instrument with a large cup, small cup mov-
ing and slurry cup the number of subsamples (additional measuring
points) can be defined.

If the user wants to average multiple cups or vials, the user can define
the number of cups/vials per sample.

Sample numbering

Defines the procedure during sample registration in Vision Air Routine.
Manual or automatic sample numbering is possible. The codes that
define strings during automatic sample numbering are described in
detail in chapter 3.3.1, on page 61.
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= Storage options
Defines which information about spectra should be stored. Beside the
spectra (read only), subsamples and the full raw data can be stored.
Subsamples are created when multiple positions are analyzed within 1
measurement, e.g. with the DS2500 large cup. The full raw data is not
accessible with the current Metrohm product line.

When activating the advanced option view under
View » Options » Display advanced settings, additional settings are
available.

= Automatic export and print
Allows to activate/deactivate automatic print and export procedures.
This option applies to operating procedures that are linked with a
method.

= Check sample operating procedure
Shows the number of replicates (read-only).
If the checkbox Pass/fail visualization is enabled, the predicted result
is shown. If the checkbox is not enabled, only a pass / fail information
is shown.

= Compatibility (only available for DS2500 Solid Analyzer)
Allows all spectra to be collected to be compatible with old 6500/5000
System Il series. This functionality is not used anymore with the current
Metrohm product line.

= RFID (only available for DS2500 Solid Analyzer)
Activation and deactivation of RFID recognition. This functionality is not
used with the current Metrohm product line.

3.1.9 User-defined fields section

LLLLL LU L LU LR

The User-defined fields section contains the following work window
tabs:
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Summary

= The name of the user-defined field.
= Settings that affect the behavior of the user-defined field during sam-
ple registration.

Values
Creating, deleting and editing values of user-defined information.

3.1.10 Users section

The Users section lists all users.

Users can be created, deleted and edited.
The Users section contains the following work window tabs and settings:

Users that were created with no user role are displayed in the No
assigned users section.

The Users section contains the following work window tabs:

Summary

= The user can define a user name and further contact information, for
example e-mail address, phone number and working address.

» Information and settings regarding the individual users.

= By activating the check box Disabled in the Account information
area, the user is not able to log in and the following message appears:
"The system could not log in. Make sure the user name is correct, and
type your password again. Letters must be typed using the correct
case".

= A user is locked if they type in a wrong password 3 times (default val-
ues). To unlock a locked user, select the user in the structure window
and deactivate the checkbox next to Locked.
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= To change the password, click on [Change password], fill out the
Password, Confirm password fields and click on [OK].

= Date and time when the user's password was last changed is shown in
the Password changed at: field.

= By activating the check box Password never expires in the contact
information of a specific user, the user is never asked to change the
password.

= Send the Vision Air Manager Network installer to a selected user with
the [Send link info] button. To send the information an e-mail
address needs to be intered in the field Email.

Roles

Select a user to see the assigned networks, instruments groups and instru-
ments.

Add or remove networks, instruments groups or instruments with [Add]/
[Removel].

Check Is System Administrator to grand administrator rights to the
selected user.

User roles and descriptions

= Instrument User
Access to an instrument in Vision Air Routine. Which instrument the
Instrument User has access to is defined by the Network Manager or
the System Administrator. System Administrators and Network Manag-
ers can create/modify Instrument User accounts. Only System Adminis-
trators can delete Routine User accounts.

= Group Manager
Access to group(s) of instrument(s) in Vision Air Manager. Which
group(s) and instrument(s) the Group Manager has access to is defined
by the System Administrator. System Administrators can create/delete/
modify Group Manager accounts.

= Network Manager
Full access to network(s) with group(s) of instrument(s) in Vision Air
Manager. Which network(s), group(s) and instrument(s) the Network
Manager has access to is defined by the System Administrator. System
Administrators can create/delete/modify Network Manager accounts. A
Network Manager can modify his/her own account but no other Net-
work Manager accounts.

= System Administrator
Full access to all networks with group(s) of instrument(s) in Vision Air
Manager. Only System Administrators can create/delete/modify other
System Administrator accounts.

Login Properties - Options and Description

To access the login properties, right-click on All users in the structure
window and click on [Login properties].
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Login Options

= Password expiration (days)
After this time, the user has to define a new password.

= Warn about password expiration (days)
Defines a reminder before expiration. In days before expiration takes
place.

= Allowed login attempts
Defines how many login attempts with an incorrect password are per-
mitted until the user will be locked.

Logout options

= Automatic logout
If the automatic logoff is activated, the user will automatically be log-
ged off after the pre-defined time without any user interaction.

= Automatic logout timeout (minutes)
Time in minutes until an automatic logoff takes place.

Password complexity

= Password minimum length
A minimum password length can be defined here.
» Prevent reuse of recent passwords
The number of recent passwords that are not permitted.
= Use numbers and letters
If activated, the password must contain numbers and letters.
» Use upper and lower case letters
If activated, the password must contain upper and lower case letters.

Enable/Disable User Management (non-pharma)
If you do not want a permanent check during start-up of Vision Air Rou-
tine or Vision Air Manager, User Login can be set to automatic mode.

Go to View » Security Options. Activate Enable automatic login.

3.1.11 Configuration change section
The Configuration Change section lists all existing configuration
changes. In order to apply changes to clients a configuration change
needs to be published.
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Operating Procedures

DC w.large cup -no registration

Methods.

Methods

Large cup no registration (New)

Name

New Value

Large cup no registration

New Value
Large cup no registration

Old Value
Large cup

Old Value

In a configuration change all changes, e.g. a parameter within an operat-
ing procedure, are listed and can be compared with an earlier state of the

configuration.

Symbol Description

Pending

o Published

C In progress

& Cancelled

G Failed

& Completed
The Configuration Change section contains the following work window
tabs:
Summary

Information about the selected configuration change is displayed.

Instrument Updates

In this tab the content of the configurations changes is displayed.
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3.1.12

Surveillance section

The Surveillance section lists all samples, diagnostic tests and events.

By right-clicking in the structure window, the user can set the following
options.

Clear flags

Flags (error @ / warning « ) that are displayed for an instrument in the
structure window can be cleared. The user can enter a Reason for
clearing the flags in the pop-up window.

The Flags log report shows the history 1 month back in time, includ-
ing information on who cleared specific flags and the reason for doing
it.

Depending on the situation, status symbols can be shown in the events
(¥), diagnostics (), operating procedure limits (&) and outlier (£2) col-
umns.

Show shewhart chart

The shewhart chart is a control chart that is used as a tool to supervise
the analysis of check samples.
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D52500 Instrument CC Spec 91814347

~) Filter options

Operating Procedure: Checksample Standard - plot axis

@ sample # on X
O Sample date on X

Parameter: Theoretical value i
Limit number of samples: 100

Analyzed period

From:  18/052018  [&] 1200AM ~ To: 5] -
Filter Reset
Check-samples

(Zoom: use mouse wheel or select area)

100.64 - d

96.64 Action limit
Waming limit
85.64 Moving action limit

Moving Warning limit mmq
94.64 - =—@— Parameter

Moving average

Target

T
1 2 3 4 5 6 7

oK

Enable/Disable surveillance

It is possible to disable the surveillance of an instrument. After disabling,
the instrument is not flagged anymore, for example after a failed instru-
ment diagnostic test. This function can be used when there is a known
problem with an instrument and there is no need for surveillance prior to
corrective maintenance. To do this, right-click on the instrument in the
structure window and select Disable surveillance.

The Surveillance tab contains the following work window tabs:

Samples

In the Samples tab, the user is given an overview over all the measured
samples within the set filter settings.

Depending on the situation, status symbols can be shown in the raw data
(=), reference data (&), events (¥), outlier (£2) and operating procedure
limit (&) columns. These symbols are summarized in the Status symbols
section.

Samples for which outlier limits and/or operating procedure limits are
exceeded are colored yellow (warning limits) or red (intervention limits).

E Filtering is not case-sensitive, e.g. ‘A" and 'a" are treated equally.

E Always click on [Save] after changing a sample number and before
initiating a new filter search.

By activating the check box Show sample information:, extra informa-
tion such as method used and user-defined fields input are immediately
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displayed in the sample list. By activating the check box Show secondary
parameters:, parameters such as distance for identification and qualifica-
tion predictions are displayed in the list.

By clicking [Edit] in the Advanced filters area, up to 5 different
advanced filters can be added.

With the [Match] option in the advanced filter area, you can define that
samples must match all the defined filters or any of them. The [Reset]
button resets all the filter settings.

[} When advanced filters are active, this is displayed in the main view.

Export

The data of (a) highlighted sample(s) can be exported by clicking on
[Export...]. In the Samples export options window, the user can
change the following default export options:

55 Select options for sample export

Select export options

Select file format i XML sample files (*.xmi) vi

General options
Include subsamples

Include samples with no spectra

XML options
Include protocols
Include complete raw data

Export to one sample file and separate raw data files

.NIR and .CAL options
Trim spectral range 400 - 2500 nm

Custom range (nm) 400 - 12500
Trim spectral resolution | 0.5 nm

Apply ISI standardization to raw data

Standardization group

Also create ANL files

Excel and .CSV options

Include secondary parameters

.

Cancel

In the Select file format drop-down menu, the for-
mats .xml, .xIsx, .csv, .nir and .cal can be selected.

Samples that are exported to .xml can be used for prediction model devel-
opment in Vision, The Unscrambler and PLS_Toolbox. The additional set-
tings under .xml options are only available when choosing .xml export.
The Include protocols option exports additional information, such as the
kind of analyzer or sample vessel that was used for the analysis.

Samples trend
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By right-clicking on a selected sample, a context menu (samples graph) is
available that allows to plot the predicted quantitative results in a trend
chart. Contrary to Vision Air Routine, more than 2 quantitative parameters
can be displayed in parallel.

W& samples Trend

(~) Options

Parameters to display trends for plot axis

Cetan index - @ Sample # on X
CFPP [*C] (O Sample date on X
Density [g/mL] =
Viscosity [cSt]

Cetan number

Flash point [°C]

Show

Predicted values for the selected samples
(Zoom: use mouse wheel or select area)
60.000

50.000 %

40.000 -

30.000

Predicted value

20.000

—e— Cetan index
=& Density [g/mL]
Viscosity [cSt]
* * =

10.000

1
R 23

0.000 e
] 1 2 3 4 5 6 7 8 9

oK

E It is possible to view more than 1 sample in the Samples trend win-
dow. To do this, press the [CTRL] key and select a number of sam-
ples in the sample list. Then click on the [Samples trend...] button.

Sample details

By double-clicking on a sample in the sample list, the Sample details

window appears. Alternatively, the Sample details window is accessible
by right-clicking on the sample and selecting [Details]. The upper section
of the window shows general information and sample information values.

The Sample details window contains the following tabs.
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» Predicted values
This tab lists the predicted values of the sample including subsamples,
if relevant. The list indicates the quality (@) of the sample and if the
sample is an outlier (£2) and/or outside operating procedure limits (£2).
Results for secondary parameters are also listed in this view.

Entity L. k2 @ Lactose Content [#-%] t-statistics | Comment
SubSample 1 -102.20

SubSample 2 -10176

SubSample 3 10549

SubSample 4 -101.29

SubSample 5 -105,68

SubSample 6 -10179

SubSample 7 -10274

Raw Result -102.99

Reported Resuit @ [s3s |

Standard Deviation 1826
Min -105,675
Max -101,292

The result in the Raw result row is the predicted value of the mean
spectrum (depending on the type of instrument and settings) before
post-processing i.e. Moisture compensation and Slope/intercept.
The Reported result is the main result that is also displayed on the
Result display in Vision Air Routine.

= Sample events
Sample events displays all events that are related to the sample, e.qg.
when quantitative results exceed the set limits.

» Reference values
By clicking on the Reference values tab and double-clicking in the
Reference value column, reference values can be edited.
An edited reference value is shown in a Sample detail report. It is
also included in sample exports and available when calculating slope
and intercept.

= Sample data
The Sample data tab shows the spectrum of the samples.

» Instrument protocol
The Instrument protocol tab displays the sample vessel used, hard-
ware specific information and information concerning the software
version.

= Parameter protocol
The Parameter protocol tab displays the prediction model used and
slope and intercept values for the individual prediction models.

= Operating procedure limits audit trail
The Operating procedure limits audit trail tab displays the set lim-
its and targets for the quantitative prediction models that were used
for the measurement.

Diagnostics

In the Diagnostics tab, an overview over all diagnostic tests within the
set filter settings is displayed.

By double-clicking on a diagnostic test, the Test details window appears.
Alternatively, the Test details window is accessible by right-clicking on
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the diagnostic test and selecting Details. The upper section of the win-
dow shows general information and steps that are conducted during the
test.

The diagnostic test contains the following steps:

1. Lamp test
Tests whether the voltage is ok and the lamp uses the expected cur-
rent.
2. Grating test
Tests whether the grating moves smooth and with the correct speed.
3. Detector 1
Tests the functionalities of the individual detectors of the spectro-
graph.
4. Main hardware test
Checks whether a sample holder is present and which type of sample
holder it is. Measures the temperature of the sample holder and esti-
mates the sample temperature.
5. Stability test
Tests whether the system is running stable. The noise value of the
spectrometer is used for the stability test.
6. Wavelength test
Tests whether the wavelength axis is within the allowed tolerances.

By selecting a step and going to the Data tab, the collected data is shown
respectively. Not all steps include data. Some tests, e.g. wavelength tests,
show absorbance spectra and tables with respective acceptance values.
Acceptance values are displayed when hovering over the individual col-
umns of the table.

Events

In the Events tab, an overview over all events within the set filter settings
is displayed. There are 3 kinds of events.

= Instrument specific
E.g. instrument diagnostic test canceled.
= User specific
E.g. user logged into Vision Air Manager.
= Software specific
E.g. new instrument configuration is created.
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3.1.13 Sample lists section

The Sample lists section allows managing large data sets by using
dynamic sample lists and static sample lists. Updates of quantitative pre-
diction models are conducted with slope corrections and intercept correc-
tions by using dynamic sample lists and static sample lists.

By right-clicking on the structure window, a new sample list group can be
defined. The new sample list group is used as a folder for dynamic sample
lists and static sample lists. A new sample list is dynamic by default. A new
sample list is created within this sample list group by right-clicking on the
folder.

Summary

= Name of the sample list.

» Information on when the sample list has been created and modified. If
no modification has been conducted, the time stamp for modification
and creation are identical.

= By activating the Static check box, the sample list is modified to a
static sample list. A static sample list cannot be reverted to a dynamic
sample list. The sample lists that match the filter settings are fixed.
Afterwards, the filter settings are not available anymore for this static
sample list.

Samples

Surveillance view with different filter settings. The set filter settings are
stored within the sample list. The results are updated automatically. For
static sample lists, only the previously defined spectra are displayed.

Reference values

Displays entered reference values with respect to samples that match the
filter settings defined in the samples work window tab. Missing reference
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values can be added within this window. When users try to enter a refer-
ence value for a sample that was not measured with the respective
parameter profile, reference values are not stored after clicking on the

[Save] button.

Slope/intercept

Adjustment of quantitative prediction models by using a slope correction
and intercept correction (see "Slope/intercept calculations”, chapter

3.3.8, page 75).

3.2 Vision Air Routine

3.2.1 User interface

Help  Seitines B X

R Powder and Waster Analysis - Batch Number |, Smail cup (stationary) | 2
st
L=rs o Operating procedure B+ &8
Fowrder and Water 3

5— @
1 Data window

3 Information field

Operating procedure name and time when

the sample was measured.

5 Start button

Analysis - Baich

Details
Samole number
Polymer Composition-004

sample comment
Chodk Sample —4

List of operating procedures

Sample registration details field
Additional information that was entered
during sample registration.

Navigation window
Options that enable the user to navigate
through Vision Air Routine.
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L2 Metrohm

NIRSystems

Details

Result
Displays the most recently calculated result
with respect to the selected operating pro-
cedure.

Trend
Graphical display of results over time with
respect to the selected operating procedure.

Tools
Section for report creation, instrument tests
and general settings.

History
Displays all the collected results with respect
to the selected operating procedure.

Details
Extended sample information, e.g. spectra
display.
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System Events

Help Settings — [ X

4 Caffeine Small cup v
1 2
System event indicator 2  List of operating procedures

The system event indicator flashes yellow ()
when 1 or more system warnings in the list
are waiting for a user action. If the list also
contains errors, the system event indicator
flashes red (#) and the [Start] button
becomes inactive.

To open the system events list, click on the

system event indicator (#/) in the top right
corner of the screen.

3.2.2 Results section

Metrohm Help Settings __ B %
NIRSystems &R PET Analysis Quant , Small cup (stationary) =

Operating procedure 1/ &

PET Analysis Quant
Date: 26/09/2018
Time: 35821 PM

Details
‘Sample number
Sample-017
‘Sample comment t

Batch Number

®

Result tab

In the Result section, the result that was selected in the history view is
displayed. Normally, this is the sample that was analyzed last. This view
includes column headers that show the name of primary and possibly sec-
ondary parameters of the selected operating procedure.

L. k= Parameter Value

The header is divided into the following column fields. See next section for
a description.
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Sample event icons

» Outlier status (£2) indicates if a given parameter is outside of the outlier
limits: If a sample was identified as an outlier, a warning () or error (H)
icon is shown.

» Operating procedure limit status () indicates if the predicted value for
a given parameter is outside of the limits: If a quantitative result is out-
side of the warning limit or intervention limit, a warning () or error (H)
icon is shown respectively.

Results with warning markings or error markings are indicated by yellow
and red background colors, respectively. If 1 of these markings is shown,
the reason for this is displayed at the bottom of the result window.

Sample event Code

! Too much light - Sample too light |
Check the sample cup

Result value

Primary parameter value (predicted value) is followed by possible secon-
dary parameters (depending on prediction model settings). If a parameter
cannot be predicted for some reason, the field contains a "-" (minus) sign.

In the case that the selected operating procedure contains an identifica-
tion prediction model or qualification prediction model, a primary value is
displayed as a text string, e.g. lactose or different mesh sizes. If enabled,
secondary parameters are displayed, e.g. Confidence or Max. distance.

Result
Lo k= Pparameter Result

Polyethylen conc. %] 4905

= Confidence ranges from 1 down to 0. Good confidence is close to 1.
» Max. distance shows the highest allowed normalized distance from
unknown sample to best match sample group.
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History section

£ Metrohm

Help setings _ B X

NikSystoms B PET Analysis Quant small cup satonary) |

Result Samples Operating procedure  #/ &

8= & A F L k= 9/ Operating procedure Time
History

Sample number Intrinsic Viscosity Total Acid Number Moisture [%]

PET Analysis Quant
Date: 26/09/2018
Time: 315821 PM

& ra U 26/09/2018358PM  Sample-016 315 241 401

& 77 4n t 26/09/2018 357 P Sample-015 315 241 401 -
Details

® 757 an ' 13/06/2018 G11PM  Sample-0014 315 241 401 sample
E

® 77 an ® 13/062018 6:11PM  Sample-0013 208 2176 342

& 774 't 13/0620186:11PM  Sample-0012 255 1604 100

13/06/2018 6:11 P4 Sample-0011 274 1869 199

»
z

13/06/2018 610 P4 Sample-0010 201 274 309

® 77 an % 13/062018 6:10PM  Sample-0003 315 241 401

13/06/2018 6:10 PM

13/06/2018 6:10 PA

13/06/2018 6:10 PA

& Poan 13/06/2018 61071 Som 201 2074 309
® 7o an 3/06/2018 610 P Sample-0004 315 21 401
& e ar U 13062018 610PM  Sample-0003 298 276 202

U 13/06/72018 610 PV Sample-0002 255 1604 100

uant 13/06/2018 607 PV Sample-0001 274 1868 199

®

History section

The History view shows a list of sample results that were measured with
the selected operating procedure.

UMW A Operating procedure Time

Sample number ID_Polymer Polyethylen Conc. [%]

Sample event icons and further information in the data window:

Raw data status: The type of icon indicates what kind of data has been
stored to the database. When extra data is attached to the sample
result, a data type icon is displayed in the left column: Sensor and pre-
processed data (), Pre-processed data (&4, default data type).
Reference data status (&): When a reference value has been added to a
sample, a reference icon is displayed.

Sample events status (¥): A warning () or error (H) icon is displayed
for hardware specific issues, e.qg. if the lid of the DS2500 instrument
was open during measurement.

Outlier status (£): A warning (') or error () icon is displayed if a sam-
ple has been identified as an outlier.

Operating procedure limits status (2): A warning (') or error (H) icon is
displayed if a quantitative result has been identified to be outside of
the warning limit or intervention limit.

Operating procedure: Sample number of the operating procedure.
Time: Indicates at which time the sample was analyzed.

Sample number: User-defined or automatically generated sample num-
ber.

Parameter name: Parameter names, e.g. "Water content”, are men-
tioned in the order that has been set for that operating procedure.

Reference data

It is possible to add reference values to predicted parameter values.
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Samples
ﬂl & F L. k2 Time Sample number Operating Procedure Lactose_Content [%]
] 9/4/2015 1:13 PM Caffeine A
=] 9/4/20151:13PM 28 Caffeine 5235
=] 9/4/20151:13PM 27 Caffeine 56.45
[~] 9/4/20151:13PM 26 Caffeine 55.78
(] 9/4/20151:13PM 25 Caffeine 54.25
(<] 9/4/20151:13PM 24 Caffeine 54.83
=] 9/4/20151:13PM 23 Caffeine 5375
& 9/4/20151:13PM 22 Caffeine 53.98
=] 9/4/20151:12PM 21 Caffeine 53.16
=] 9/4/20151:12PM 20 Caffeine 56.89
=] 9/4/20151:12PM 19 Caffeine 57.45
=) 9/4/20151:12PM 18 Caffeine 56.78
=) 9/4/20151:12PM 17 Caffeine 50.98
<] 9/4/20151:12PM 16 Caffeine 5345
(<] 9/4/20151:12PM 15 Caffeine 52.89
N v

First, select the samples for which reference data should be added. A sam-
ple is selected by clicking on the row. Multiple samples can be added by
pressing the [CTRL] key simultaneously. Right-click to open the following
dialog.

Click on a reference field to enter a reference value.

Alternatively, reference values can be imported with .csv files (see "Import-
ing reference values with a .csv file", chapter 3.3.3, page 67).

Enter reference values 7
Parameters
Polypropylen Conc. Water Conc. Polyethylen conc.
Time ‘ Sample number ‘ Polypropylen Conc. [%] | Polypropylen Conc. Ref. ‘ Water Cone. [Volume-%] ‘ Water C
< >

Exporting sample data

It is possible to export the selected sample data to a file in CSV, Excel, rich
CSV, rich Excel, NIR or CAL format from this menu.
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Trend section

Help settngs B X
NIRSystems R PET Analysis Quant ,small cup (stationary)
Grph
Graph b4 Operating procedure  #/ &
Intrinsic Viscosity v —— Curent = 315 v
320 PET Analysis Quant
Date: 13/06/2018
Time: 6:10:56 PM
e Details
200
20
280-
270-
260
250 ,
Sémple-0001 Sample-0003 Sample-0005 Sample-0007 Sample-0009 Sample-0011 Sample-0013 Sample-015 Sample-017
®

The trend graph shows quantitative values for the selected parameters of
the current operating procedure.

Graph S

Polypropylen Conc. [%] v Current = 8.75 Current = 9.78 Water Cone. [Volume-%]
70.00 10,00
60.00 9.00

8.00
50.00

7.00
40.00-

6.00
3000

500
2000

400
1000 3.00

0,00 200

T T T T T
Polymer C.. Polymer C...  Polymer C.. Polymer C...  PolymerC...  Polymer C.. PolymerC..  PolymerC..  PolymerC.. PolymerC...

Figure 1 Main graph

The trend graph can show 1 or 2 parameter plots. Parameters are selected
by using the “Green Plot” and “Orange Plot” drop-down lists on top of
the graph. The lists contain all the parameters that were investigated with
the currently selected operating procedure.

If only 1 graph is displayed, a graph for the running average can be dis-
played. If upper and lower warning limits, intervention limits and a target
value have been defined in Vision Air Manager, they are also shown, so
that up to 5 horizontal lines are displayed.
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Graph 56
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If a measured value is selected in the graph, a vertical orange line is dis-
played that highlights the selection. The upper middle part of the window
shows the quantitative result(s) of the selected measurement.

Trend settings

The settings field contains the [Trend settings] button that gives access
to the Trend settings dialog window.

Graph view settings ?
Parameter graph options:
Show moving average curves

Number of samples for average calculation: 10
X-axis options
@® Use an equally spaced scale

O Use a true time scale

Max. samples: 100

Set default “ Cancel

The following trend settings are available:

= Parameter graph options
Show moving average curves: This defines if a moving average should
be calculated and displayed as well as the number of recent samples to
include in the calculation.
Number of samples for average calculation: The running average calcu-
lation is based on the defined number of samples.
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= X-axis options
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Use an equally spaced scale, i.e. the x-axis distance between samples

must be equal.

Use a true time scale, i.e. the x-axis distance between samples is pro-
portional to the time between the measurements.
Max. samples, i.e. the graph shows "max." sample results, from the
most recent samples.

« Set default

By clicking the [Set default] button, the last graphical settings are
saved and used thereafter.

Details section

£ Metrohm

NIRSystems

Spectrum Protocol

Help Settings __ BBy X
B PET Analysi Quant_small cup statonary) |

Vision Air Local
13/06/2018
610356 PM
nature: FF76-B62F B

Details

*sample number
Sample-0008

Sample comment

Batch Number
1230448021

Operating procedure  #+ &

PET Analysis Quant
Date: 13/06/2018
Time: 6:10:56 PM

Details

Batch Number
12:X344-BC21

Information tab
Information Result Subsamples Spectrum Protocol
Sample Registration b4 Details hie
Operating procedure <] *Sample number

Powder and Water Analysis - Batch Number £

QOrigin: Vision Air Local
Date: 5/06/2018
Time: 7:46:41 AM

Sample signature: F918-C517 ¥

Database ID: 336
Sample type: Normal

<

Polymer Composition-002

Sample comment

*Batch Number
M242352

Country
China

In the Information tab, extended information is available for a specific
sample. It is also possible to edit or add additional information (depending

on the operating procedure settings).
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= Sample registration
Fixed information of the selected sample.
— Sample signature

A signature/checksum for the sample that is created at the time
of analysis.
— Database ID

An internal ID in the Vision Air database.
= Details

Sample registration information that can be edited.

Click on the [Save] button after every change.

Result tab
Information Result Subsamples Spectrum Protocol
Detailed result 2

L k= Parameter Result Distance
Powder Type PP/PE Mixture 098
Quality Polymer Good 1.00
Polypropylen Conc. [%] 69.57
Water Conc. [Volume-%] 234
Polyethylen conc. [%] 3043

< >

The Result tab shows the same information as the Result view. This does

not apply for measurements with subsamples or multiple cups where the
standard deviation of the result is displayed.



Subsamples tab

Information Result

Subsamples

Vision Air — Functional description

Spectrum Protocol

Subsamples

Entity

@ Lactose_Content [%]

Subsample 1
Subsample 2
Subsample 3
Subsample 4
Subsample 5
Subsample 6
Subsample 7
Subsample 8
Reported Result

SD

52.89
5145
56.18
57.98
55.16
57.19
54.48
53.95

0.26
5145
57.98

<

The Subsamples tab shows subsample results, the reported result, stand-
ard deviation of the results, min. values and max. values. Thus, it is possi-
ble to study whether some subsample results differ from others.

Spectrum tab

Information Result

Subsamples

Spectrum Protocol

Sample Details

Subsample spectra: 0
Mean spectrum: 1

Absorbance spectra

Abs/[au]

08

%42

612 862 1112 1362

Minm]

1612 1862 2112 2362

57



58

Vision Air Routine

The Spectrum tab shows the absorbance spectra of the analyzed sample.
The number of displayed subsamples depends on the settings.

Subsample storage needs to be activated in the storage option of the
method. Additionally, the number of subsamples needs to be defined in
the repetition setting of the method. Not all accessories allow the collec-
tion of subsamples.

Protocol tab

Information Result Subsamples Spectrum Protocol

Audit Trail o

General Information (NIRS DS2500)
Cup type 2501 (Small cup)

Generic absorbance calculation 2 (Si4x6_5mm)
Intensity correction IntensityCorrection (270) Export

Generic absorbance calculation 2 (PbS4x10mm)
Intensity correction IntensityCorrection (281) Export

Local Vision Air settings (Vision Air)

Automatic printing enabled Yes
Automatic reports enabled Yes
Automatic reports path USB:\Metrohm\AutomaticReports
CSV export enabled Yes

Automatic CSV and Excel export path  USB:\Metrohm\DirectExport
Manual CSV and Excel export path USB:\Metrohm)\DirectExport
Manual reports path USB:\Metrohm\ManualReports
Printer name

Analysis (NIRS DS2500 Base)
Autolinearisation enabled No
Number of reference subscans 32

Compatibility (NIRS DS2500 Base)
NIRS 6500/5000 compatibility mode No

RFID (NIRS DS2500 Base)
Cup serial number 0
Cup type check Yes v

<

The Protocol tab gives an overview of measurement settings for the ana-
lyzed sample.

Some settings are relevant to the instrument (or a specific part of the
instrument) while other settings are related to parameters. The relevant
instrument part name or parameter name is shown in brackets.
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Tools section
L2 Metrohm Help  Setings __ [O0%

NIRSystems test  Disposable Vial 2 mm

Tools

Analysis Service

Reports Q Export logs

ﬁ] User manual ﬁh Export samples

L__,_L'. Remote support % Data maintenance
ﬁ Instrument diagnostics @ Instrument calibration

[i; Instrument information

User

. FER— m‘i Temperature correction

’;-_j Vision Air synchronization

# Settings

The following functions are accessible in the Tools section.

= Reports
Predefined reports are accessible by clicking on [Reports]. Predefined
reports are available for example for sample details, instrument diag-
nostics or sample lists.
A sample detail report displays a report for the selected measurement
in the History view. If no selection is made, the report is created for
the last conducted measurement.
An instrument diagnostic report displays the results of the last instru-
ment diagnostic.
Additional reports can be added in Vision Air Manager (see "Reports
and report management", chapter 3.3.2, page 64).

= User manual
The [User manual] button opens the manual for the currently con-
nected instrument.

= Remote support
The [Remote support] button allows you to initiate a remote support
session via TeamViewer.

= Instrument diagnostics
The [Instrument diagnostics] button initiates the instrument diag-
nostic test, which verifies the hardware performance of the analyzer.

= Change PIN code
The [Change PIN code] button allows you to change the PIN code.
PIN codes are used when creating a manual backup, restoring a
backup, creating a check sample operating procedure or performing a
photometric test definition.
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Low flux noise test (external standard) (only available for XDS instru-
ments and DS2500 Solid Analyzer)

The [Low flux noise test (external standard)] button starts a low
flux test. For the low flux test, an external optical density filter is used
to measure the instrument performance at lower light intensities.
Wavelength certification (only available for XDS instruments and
DS2500 Solid Analyzer)

The [Wavelength certification] button starts a wavelength test. For
the wavelength test, an external wavelength standard is used to meas-
ure the accuracy and precision of the analyzer with respect to the
wavelength axis.

Photometric test (only available for XDS instruments and DS2500 Solid
Analyzer)

The [Photometric test] button starts a photometric test. For the pho-
tometric test, an external optical density filter is used to measure the
linearity of the instrument within a defined absorbance range. Before
starting a photometric test, a photometric test definition needs to be
executed.

Export logs

The [Export logs] button allows you to export log files for trouble
shooting purposes.

Export samples

The [Export samples] button allows you to export collected measure-
ments. A folder with an .xml file is created in the selected destination.
Data maintenance

The [Data maintenance] button allows you to start a backup of the
database, to restore an existing database or to delete samples for a
defined time period.

Instrument calibration (only available for DS2500 instruments)

The [Instrument calibration] button starts instrument calibration
with the internal wavelength filter or with the external wavelength fil-
ter.

Instrument information

The [Instrument information] button opens the Instrument infor-
mation window. The Instrument information window displays
information on the Vision Air version used, the analyzer name that is
defined in Vision Air Manager and some computer specific informa-
tion, for example the IP address.

Temperature correction (only available for DS2500 Liquid Analyzer)
The [Temperature correction] button allows to correct the tempera-
ture difference between the sample holder and the sample.

Vision Air synchronization

The [Vision Air synchronization] button allows to manually syn-
chronize results that were collected in Vision Air Routine with Vision Air
Manager Network (see "Synchronize with Vision Air Server", page
127).
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= Settings
The [Settings] button grants access to different settings.

Vision Air sync

In the Vision Air sync section, the user can define a connection
to a Vision Air Manager Network system.

Import

In the Import section, the user can import configuration files or
directly access Vision Air Manager.

Export

In the Export section, the user can define the storage locations
for reports and results and allow an automatic export set in
Vision Air Manager.

Print

In the Print section, automatic print can be activated. Automatic
print is set in Vision Air Manager. Additionally, the print template
and the printer itself can be selected.

Protocol

In the Protocol section, the user can select a storage location
for information that is displayed in the Protocol section, in the
Details section of Vision Air Routine.

Backup

In the Backup section, the user can set an automatic backup
plan and define the storage location.

Instrument

In the Instrument section, the user can modify a global counter
that can be used during automatic sample numbering.

= Photometric test definition (only available for XDS instruments and
DS2500 Solid Analyzer)
The [Photometric test definition] button allows you to define refer-
ence values for the photometric test by using external standards.

3.3 Specific functions in Vision Air

3.3.1 Sample numbering

The sample numbering is used during the sample registration step. The
sample number defines the sample name.

Sample numbering options are specific for each method. It is possible to
define mode-specific options, if sample numbering is enabled and what
numbering mode (manual or automatic) is used.
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Manual sample numbering

Setting Groups

@ setiinos related to sample numbering. The help system contains an artcle on sample numbering options

Sample number enabled:

If the manual sample numbering option is selected, the user is asked to
enter the sample number during measurement in Vision Air Routine.

There are 2 options for manual sample numbering:

Sample number mandatory

If a sample number is marked as mandatory, it is not possible to com-
plete measurement without entering data in the sample number field.
Repeat sample number from previous sample registration

This can be selected if a sample number is rather long, contains a lot of
information and only a small part of it is changed for the next sample.
If the user wants the sample number to be transferred from the previ-
ous sample registration, the corresponding setting must be selected.

Transfer rules:

A pop-up window with the sample number appears during measure-
ment even if transfer is activated. The user may edit the sample num-
ber or just leave it as is.

The sample number is transferred from the previous sample registra-
tion, even after restarting Vision Air Routine.

If measurement was canceled from the registration form, the sample
number is not used for the next transfer, even if it was already entered.
Transfer is started on the second sample after the corresponding set-
ting has been selected.

If the sample number was changed manually for any previous sample,
the new value is used for the transfer.

Automatic sample numbering

Analysis

Setting Groups

bering. The help system eontains an article on sample numbering options

Notice:  Automatic sample numbers are mandatory,
iies the generated number will automatically
be attached to each sample
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If the automatic sample numbering option is selected, the sample number
is generated automatically during measurement using the defined mask.
The mask should be entered into the text field and may contain the fol-
lowing formatting codes, which are substituted by real data:

« [INSTRUMENTNAME] — name of the current instrument
= [PRODUCTNAME] — name of the current operating procedure
= [PRODUCTCODE] - code of the current operating procedure (numeric
value)
[HH] — hours in 24 hour format
[HHHH] — hours in 12 hour format (AM/PM)
[MM] — minutes
= [SS] —seconds
[YY] —year (13)
[YYYY] - year (2013)
[Y] — year (3) #-###### — consecutive sample counter. Number can
have 1(#) to 6 (######) digits. Number starts with 0...01 and incre-
ments on every measurement.

Truncation:

It is possible to truncate strings in [PRODUCTNAME], [PRODUCTCODE] and
[INSTRUMENTNAME] by appending the %n sign, e.g. INSTRUMENTNAME
%3]. If the string is longer than the defined number, it is truncated to the
corresponding length (3 in the example) otherwise it is padded with
spaces.

Example:

“"[PRODUCTNAME%10] Sample-### [HH].[MM]"

Mask creation rules

= All formatting codes, except number sequence, must be written in
square brackets [ ].

= All formatting codes must be upper case.

= |tis allowed to have only 1 number sequence (###) in the mask.

= [tis allowed to not have any number sequence in the mask at all.

= [f the formatting code was misspelled, it is not substituted by any value
during sample number generation, and it is just left as is.

General sample numbering rules

= A sample number is generated on every measurement using the
defined mask. The registration form is not shown to the user if only the
sample number is required. If user-defined fields or sample comments
should also be entered, the registration form is shown with the sample
number already entered.

= The number in sequence (###) is incremented on every subsequent
measurement.

63



64

Specific functions in Vision Air

An automatically generated sample number can be changed by the
user if the Allow edit setting is selected in Vision Air Manager.
Automatic sample numbering is always mandatory; so it is not allowed
to change it to an empty string.

If the mask was changed in Vision Air Manager, the number generation
starts from the initial number (the number sequence is reset to 0...01).
When the maximum number is reached e.g. 99 for a ## mask, the ini-
tial number is applied on the next measurement (01).

If the sample number was changed manually by the user, then it is
checked during the next measurement if the entered number matches
the mask. If yes, the entered number is used as a base when generat-
ing the subsequent number, e.g. with the following number sequence:
001, 002, 003, when 003 is changed to 123, the next sample number
is 124.

If the entered sample number does not match the mask, the previous
valid number is used when generating the next number. Another
example, with the following number sequence: 001, 002, 003, when
003 is changed to abc, the next sample number is 004.

If the sample numbering mode is changed from manual to automatic,
generation is started from the initial number even if the manually
entered value matches the mask.

The user can define when the sample numer sequence is reset: never,
when a date changes, when a month changes or when a year
changes. If the date/month/year changes, the number in the sequence
is reset to the initial number.

3.3.2 Reports and report management

Reports can be created for Vision Air Routine and Vision Air Manager. Not
all reports that are available in Vision Air Manager can be accessed in
Vision Air Routine.

According to the current navigation window and current work window
tab, the report menu shows different entries:

Instrument detail

This report is available when Instruments is selected in the navigation
window.

Prediction model list

This report is available when Prediction models is selected in the nav-
igation window.

Prediction model list with details

This report is available when Prediction models is selected in the nav-
igation window.

Instrument slope/intercept 30 days

This report is available when Surveillance is selected in the navigation
window.



Vision Air — Functional description

= Instrument status
This report is available when Surveillance is selected in the navigation
window.

= Flags log
This report is available when Surveillance is selected in the navigation
window.

= Instrument check samples 5 days
This report is available when Surveillance is selected in the navigation
window.

= Instrument group events 30 days
This report is available when Surveillance is selected in the navigation
window.

= Instrument group audit events 30 days
This report is available when Surveillance is selected in the navigation
window.

= Sample list
This report is available when a sample is selected in the sample work
window of the Surveillance navigation window.

= Sample list (landscape mode)
This report is available when a sample is selected in the sample work
window of the Surveillance navigation window. The report will be
displayed in landscape format.

= Sample detail
This report is available when Surveillance is selected in the navigation
window.

= Simple single sample
This report is available when a sample is selected in the sample work
window of the Surveillance navigation window.

= Instrument diagnostics
This report is available when Surveillance is selected in the navigation
window and a self test is selected on the Diagnostics tab.

= Low flux test
This report is available when Surveillance is selected in the navigation
window and Low flux test is selected on the Diagnostics tab.

= Wavelength certification test (only available for XDS instruments and
DS2500 Solid Analyzer)
This report is available when Surveillance is selected in the navigation
window and Wavelength certification test is selected on the Diagnos-
tics tab.

= Instrument events - Selected period
This report is available when Surveillance is selected in the navigation
window and the work window events.

New report templates can be added with Vision Air Manager. Depending
on the part of Vision Air (Routine or Manager), in which the report tem-
plate should be available, different sections need to be used for the
import.
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For Vision Air M

anager, report templates are imported under

File » Reports.

Y Vision Air Ma
\NA (Ds2500)

File | View Report

nager Local

Help

Cirl+S l_

For Vision Air Routine, report templates are imported under Instru-
ments » Instrument settings » Report templates.

Summary = Contact Information InstrumentSettlngs Licenses = Standardization

Configuration: ~ NIRS DS2500

(¥) Extensions

Setting Groups

Automatic export and print formats
Check-samples

Data cleanup

Diagnostic test reminders
Instrument diagnostics
Local Vision Air settings
Report templates
User-defined field values

List of available report templates for instruments
Name ‘ Template ‘ Type ‘ Format ‘

4 Sample detail | SampleDetail.rpt| Sample Detail| Portable Document Format (*.pdf) - _

Samplelist ~ Samplelistrpt  Samplelist  Portable Document Format (*pdf)

Import additional reports:  Import and add...

For automatic export in Vision Air Routine, report templates must be

imported under Instruments » Instrument settings » Automatic
export and print formats.
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Summary  Contact Information InshuszSetlmgs Licenses | Standardization

Configuration: ~ NIRS D$2500 -

¥ Extensions.

Setting Groups
UL AT E T T i s In Method settings automatic export and printing after each measurement can be enabled. The actual options
Check-ssmples are defined here at instrument level,

Commeon hardware selftest limits

Data cleanup Autematic printing options
Diagnostic test limits .

J @ No printing
Diagnostic test parameters 7) Print using report template Sample detall
Diagnostic test reminders

Harcware self test limits

Automatic export options
Hardware sensor limits

Instrument calibration sattings Export file names format [PRODUCTNAME]_[REPORTNAME J[YYYY]-[M]-[DD]_[HH]-(MM]-1s5] =
Instrument diagnostics @ e

Local Vision Air settings ) Native CSV export

Report temp ) Native CSV export including secondary parameters

Stability test limi D) Export using report template Sample detail Y

Stability test limits (S0 Additional spectral export No spectral export -

Stability test parameters
Subscan settings Impart additional reports: | Impart.
User-defined field values

Wavelength test limits (PoS)

Wavelength test limits (S)

Wavelength test parameters

3.3.3 Importing reference values with a .csv file

Reference data can be imported from a .csv file that matches the structure
of the displayed reference table.

A B C D
1 |Sample Number|Parametercode 1 |Parametercode 2
2 Sample name 1 10.1 0.5(...
3 Sample name 2 22.5 0.7(...
4 Sample name 3 40.3 1.1]...
5 Sample name 4 50.3 2.3|...

E The list separator follows the PC's regional setting e.g. semicolon,
comma, dot.

In the heading of the table, the sample number and the parameter code
for reference values are defined.

The bold string Sample number is fixed and does not need to be modi-
fied.

For the strings Parameter code x, enter the appropriate parameter code
that is defined in Vision Air Manager.

Sample names must be identical to the sample names that were used dur-
ing sample registration. Sample names must not be listed in the same
order as they were measured.

3.34 Check samples
H This feature is only applicable for DS2500 instruments.

A check sample is a sample that can be used to quickly monitor the instru-
ment’s stability as an addition to the performance tests. Artificial and nat-
ural products can be suitable check samples. For natural check samples, it
is recommended to use a sealable cup.
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The target for the check sample, no matter if it is artificial or natural in ori-
gin, can be set by performing a check sample operating procedure in
Vision Air. Any target value specified in Vision Air Manager takes prece-
dence over a calculated target value from the check sample operating pro-
cedure. When the check sample is analyzed, the predicted result is com-
pared against the target and the limits specified by Vision Air Manager.

If a check sample is used, it is recommended to analyze it at reqular inter-
vals as a routine operation. Note that the check sample operating proce-
dure may be temperature-dependent and that care should be taken to use
the definition in the standard operating environment, especially if natural
check samples are used.

To create a sample operating procedure, proceed as follows:
1 Open Vision Air Manager.

2 Create an operating procedure. Set Check sample as the sample
type.

3 Link the operating procedure with a quantitative prediction model
and a method.

4 T you know the target value of your check sample, set it in the Lim-
its tab.

If you do not know the target value, you need to evaluate it. For
evaluating the target value, follow the steps described in "Creating a
check sample operating procedure" below.

5 Define the acceptance criteria. Define the calculation of lower and
upper warning and intervention values in the Limits tab, in the Type
drop-down list. If you want to evaluate the target value through a
check sample operating procedure, select Differential or Relative.

To create a check sample operating procedure (target value), proceed as
follows:

You need to define a check sample operating procedure if no target value
has been set in Vision Air Manager.

1 Open Vision Air Routine.
2 Select an operating procedure with the sample type Check sample.

These operating procedures display an additional check box in the
operating procedure section.
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Check Sample

Figure 2 Check sample

Check Sample
(Definition) v

Figure 3  Check sample operating procedure

3 Set the check mark to run a definition in order to create your refer-
ence value for the following check sample analysis.

The default PIN code is 1234.
4 Place the check sample in the sample compartment.

5 Close the lid.

To analyze a check sample, proceed as follows:

1 Select the operating procedure for the check sample. Make sure that
the check box Check sample is deactivated.

2 Position your check sample. Click on [Start].

3 If the check sample passes, the lid opens and you can remove the
check sample and run a check sample measurement. If the check
sample test fails, follow the instructions on the screen and try again.
If the problem persists, run an instrument diagnostic test and check if
your check sample has changed. If the problem still persists, contact
your local Metrohm representative.

When not in use, the check sample should be kept in a clean and
dry location.

3.3.5 Exporting samples for prediction model development

Measurements that were carried out in Vision Air Routine can be used to
create and update prediction models that were created in Vision, The
Unscrambler or PLS_Toolbox.

To export samples, go to the Surveillance section in the Samples tab
and click on [Export...]. For the export, select the .xml file.
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Select Options for Sample Export

Select export options

Select file format XML Samples Files (*xml) -

General options
Include subsamples

Include samples with no spectra

XML options
Include protocols
Include complete raw data

Export to one sample file and separate rawdata files

.NIR and .CAL options

Trim spectral range 400 - 2500 nm

Custom range (nm) A00 - 2500
Trim spectral resolution | 0.5 nm

Apply 15 standardization to raw data

Standardization group

Also create ANL files

Excel and .C5V options

Include secondary parameters

Coce

Check Include protocols to export additional information, e.g. which
method has been used (optional). The advantage of including protocols
for the export is that data collection methods are automatically created in
Vision during a sample import.

H If you import the .xml file in Vision, the products in Vision are
named according to the operating procedure used in Vision Air. If a
product already exists in Vision, the user has to select whether the
spectra has to be included in the product or a new product name
has to be created.

3.3.6 Calculated prediction models

Calculated prediction models are defined formulas that allows you to
postprocess results and to decide which result is presented to the user.

Creating a calculated prediction model

The Create calculated prediction model editor is used to create a for-
mula. The editor can be accessed when creating a new calculated predic-
tion model. To access the editor, right-click in the structure window of the
Prediction models section and select Create calculated prediction
model. A formula can be added in the Prediction models section on
the Formula tab.
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Expression

0

Parsing results:  Formula is valid.

Operatars Functions
( exp
) if
- In
log
nat
>
>
<
>

and

Secondary Values Parameter Profiles

Confidence NULL
Custom
Discriminator
Distance

Globalt

Index

Leverage
NeighbourhaodH
NoiseLevel
NormalizedScore
Outlier
PeakHeight
PeakPosition
PeakiWidth
PhaMean
QResidual
Residusl

Rialue

Scare
SignalMean
SignalWidth
SpectralSimilarity
2

Temperature
Threshold
Totatistics

ZValue

Adding a formula

E It is important that the operating procedure for the calculated pre-
diction model also contains prediction models that include the
parameters referenced in the calculated prediction model formula.
Otherwise, an error message is displayed at synchronization.

Example 1

The example describes how to postprocess a predicted value of a predic-

tion model.

1 Add the parameter profile of the prediction model that you want to
postprocess by clicking on [Add] in the Formula tab.
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Prediction models Summary | Parameter Settings | Links | Formula

T Calculation API

Name Unit Description

Additive 1 %

API1 %

APL2 % | Parameter Profiles

Data Collection None NULL Add...
Hydroxyl Number ma/g e
Tdentity None

Intrinsic Viscosity None

Moisture %

Qual Std Correlation  None
Qual Std Distance None
Qual Std Mahalanobis None
Qual Std Residual None
Theoretical value None
Total Acid Number None

2 Remove the entries in the Expression field.

3 Enter the formula, e.g. if the result of a prediction should be divided

by 2, double-click on the corresponding parameter profile, add the
operator / and the number 2.

Expression
[Additive 1] / 2

Parsing results:  Formula is valid.

Save the calculated prediction model. Add the calculated prediction
model to the operating procedure that you want to use for postpro-
cessing.

Make sure that the operating procedure includes the prediction
model for which the postprocessing should be conducted. If the
result of the prediction model should not be displayed, select the pre-
diction model, go to the Summary tab and check Hidden in the
Linked parameter profiles window.
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Prediction models Parameter Settings | Links = Formula

" Calculation API

‘& Calculation API - Demo
“dh Data Collection Name: Calculation AP
ol Qual WL Standard Mahal
‘ol Qual WL Standard ResV
o Qual WL Standard Wavecorr Version: 106
‘#h Qual WL Standard Wavedist
& Quant WL Standard

& Simulator AP 1 Imported: 18/06/2018 9:46:56 PM Method: | CALC
o Simulator API 2

General Information

Wavelength

m

Part Number: 0

Updated: 18/06/2018 346:56 PM Engine: | Calculator
T Simulator Hydroxyl Number
#h Simulator Identification Chiorphena ™ | Comment
2l m »
(B mstruments Description:
[E] operating Procedures
b
| Prediction models
rameter Profiles Linked Parameter Profiles
Methods m Parameter name | Parameter unit| Parameter profile| Display order TR
User-Defined Fields * B M calculation % ~ APl 101

< Surveillance

E& Sample Lists

Example 2

The example describes how to use calculated prediction models for auto-
matic selection of the optimal prediction model and result display during
routine analysis. This scenario is important, e.g. if a broad concentration
range should be predicted. Typically, instead of using 1 prediction model
for the whole concentration range, multiple prediction models are used.
This increases the accuracy of the prediction. For this case, If-Then-Else-
formulas are used.

In the following example, a user has 3 prediction models.

= API Full
Parameter profile for the prediction model that is predicting a concen-
tration of API from 0 - 30%.

= API'T
Parameter profile for the prediction model that is predicting a concen-
tration of APl from 0 - 10%.

= API2
Parameter profile for the prediction model that is predicting a concen-
tration of APl from 10.01 - 30%.

Only 1 result is displayed where the software chooses whether it displays
the API 1 result or the API 2 result.

To start a prediction model, proceed as follows:

1 Add the parameter profile of the prediction model that you want to
postprocess by clicking on [Add] in the Formula tab.

73



74

Specific functions in Vision Air

Prediction models Summary | Parameter Settings | Links | Formula

T Calculation API

Name Unit Description

Additive 1 %

API1 %

APL2 % | Parameter Profiles

Data Collection None NULL Add...
Hydroxyl Number ma/g e
Tdentity None

Intrinsic Viscosity None

Moisture %

Qual Std Correlation  None
Qual Std Distance None
Qual Std Mahalanobis None
Qual Std Residual None
Theoretical value None
Total Acid Number None

e

2 Enter the formula. The following screenshots show the syntax for the

example.

Expression
if{ [APL Full] >10; [API 2] ; [APL llb

Parsing results:  Formula is valid.

if ([APIFull] >10 ; [API 2] ; [API 1] )

Parameter 1 Then Parameter2 Else Parameter 3

"If" expressions are put in brackets, the parameter profile names are
written in brackets and "then" and "else" expressions are written
with ";".

Save the calculated prediction model. Add the calculated prediction
model to the operating procedure that you want to use for postpro-
cessing.

Make sure that the operating procedure includes the prediction
model for which the postprocessing should be conducted. If the
result of the prediction model shall not be displayed, select the pre-
diction model, go to the Summary tab and check Hidden in the
Linked parameter profiles window.
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Prediction models Parameter Settings | Links = Formula

ol Calculation API
2 Calculation APL- Demo General Information

o Data Collection Name: Calculation AP
ol Qual WL Standard Mahal
#h Qual WL Standard ResV
o Qual WL Standard Wavecorr Version: 106
o Qual WL Standard Wavedist
& Quant WL Standard

& Simulator AP 1 Imported: 18/06/2018 9:46:56 PM Method: | CALC
o Simulator API 2

Wavelength

m

Part Number: 0

Updated: 18/06/2018 346:56 PM Engine: | Calculator
s Simulater Hydroxyl Number
#h Simulator Identification Chiorphena ™ | Comment
o W ,
@i Instruments Description:
[E] operating Procedures
b
| Prediction models
Parameter Profiles Linked Parameter Profiles
Methods M Parameter name | Parameter unit| Parameter profile| Display order TR
User-Defined Fields * B M calculation % ~ APl 101

< Surveillance

E& Sample Lists

[} Make sure that the Parsing results field indicates that the entered
formula is valid. If the formula is not valid, the prediction model
cannot be saved.

3.3.7 User-defined prediction model

E An operating procedure can never consist of user-defined prediction
models only.

It is possible to manually add sample parameter data that is measured
with other instruments.

User-defined prediction models can be created by right-clicking on an ele-
ment in the structure Window and selecting [Create User-defined Pre-
diction Model...].

If you create an operating procedure with 2 user-defined prediction mod-
els, the sample results include positions for both user-defined prediction
models.

During a measurement, a dialog window pops up and the user can type in
the values.

3.3.8 Slope/intercept calculations

Slope/intercept data can be displayed for quantitative prediction models in
the Prediction models section, Slope/intercept tab.

Values for slope and intercept can be changed manually in the Prediction
models section on the Slope/intercept tab.

The slope/intercept can be changed for a single prediction model or for an
instrument. The option to adjust the slope/intercept for an instrument is
sometimes required when the same prediction model is used on multiple
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instruments. Though beeing reference standardized, slight variation
between the instruments is possible.

The slope/intercept values can be adjusted for selected instruments or for
a prediction model that affects all instrument by using this prediction
model.

To calculate the slope/intercept correction, a sample list is needed.

The samples that are used for slope/intercept calculation need a reference
value for the parameter that should be corrected.

Make sure that at least 10 samples are available for the calculation
of the slope/intercept value.

Using the filter settings in the sample work tab allows you to find match-
ing samples.

Sample sets Summary Reference Values =~ Slope/Intercept
¥ [ Simulator (=) Filter optiens
& Polymer w reference
X Polymer w/o reference Sample type: All sample types
Operating Procedure:  PET Analysis Quant -
Prediction model: All prediction models ~  Samp
Reference values: With Reference Values <
Analyzed period
(e Today and last 300 days Samples to view: 100
O From: | 6/06/2018 & | 1200 AM To: 5]
Inst: 1
@ ASEEME: Show sample information: Show secondary parameters:
Operating procedures - : o )
w4 J| # || =] Operating Procedure Sample T Sample Number| Analyzed | Intrinsic Viscosity  Total Acid Number
b et i
* Prediction models [~ PET Analysis Quant  Normal ~ Sample-0012  13/06/20... 2.55 1604
@ N' PET Analysis Quant  Normal  Sample-0011 13/06/20... 2.74 18,69
rameter profiles
Ié E‘ PET Analysis Quant  Normal  Sample-0010 13/06/20... 291 20.74
Methods (=] PET Analysis Quant  Normal Sample-0007  13/06/20... 2.55 1604
Ié ﬂ' PET Analysis Quant  Normal  Sample-0006 13/06/20... 2.74 18,69
User-defined fields
@ ﬂ' PET Analysis Quant  Normal  Sample-0005 13/06/20... 291 2074
@ surveillance =iy PET Analysis Quant  Normal  Sample-0002  13/06/20... 2.55 1604
Iﬁ ﬂ' PET Analysis Quant  Normal  Sample-0001 13/06/20... 2.74 18,69

EE Sample sets

In the Sample lists section on the Reference values tab, reference val-
ues can be added or adjusted.

In the Sample lists section on the Slope/intercept tab, the correction
for the individual parameters can be conducted. 3 parameters are availa-
ble in the presented example.

Summary = Samples = Reference Values Bl 00

Parameter Slope/Intercept

Calculate S/I for other prediction models:

i ‘ Parameter ‘ Prediction madel ‘Versmn ‘ Slope ‘Intemept |
I e e e e —
Maoisture Simulator Moisture 1.0.00 1.000 0.000
Total Acid Number Simulator TAN 1.0.00 1.000 0.000

The procedure for slope/intercept correction is identical for instruments
and for prediction models.
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The procedure for the correction is explained for the parameter moisture.

To start a parameter correction, proceed as follows:

1 Select the parameter you want to correct and click on [Calculate
slope/intercept].

A window with suggested adjustments is displayed.

Proposed Parameter slopefintercept and statistics

Options and results
Sample List: Pulp and Paper
Slope intercept adjustment:  Use parameter settings -

Options related to Instrument Slope/lntercept values

(%) Keep current Instrument $/1 when calculating new Parameter 5/1
) Reset Instrument $/1 o 1.0/0.0 before calculating Parameter §/1

Accept| | Parameter | ps NewPS Pl NewPl Bias |Comelation |Accuracy (abs) Accuracy (rel)| Accuracy | Repeatability (abs) Repeatability (rel)
4 1 Applied density [g/ml] 1.000 N/A 0,000 N/A N/A N/A N/A N/A Syx M/A N/A
Accept all Reject all 0 0 of 1 adjustments marked for acceptance Details..

e

2 Click on [Details...] to see the current correlation plot and the new
correlation proposal.

alculation Details - Moisture

|Slope | Intercept | Bias Correlation | Accuracy (abs) | Accuracy (rel) | Accuracy  Repeatability (abs) Repeatability (rel)| Adjustment type |
Current 1000  0.000 0301 1000 0301 1271 RMSEP  N/A N/A
Proposed 0994  -0284 0000 1000 0013 054 Syx N/A N/A Slope and intercept
Sample List: | Polymer w reference Display: | Raw prediicted vs raw reference -
# |sample | Replicate| Predicted Refere Moisture (parameter S/1)
X Sample-0001 001 199 170 (Zoom: use mouse wheel or select area)
Sample-0002 001 100 070 a0 -
Sample-0003 001 342 310
Sample-0004 001 401 370 35 |
Sample-0005 001 309 280 a0

Sample-0006 001 199 170
Sample-0007 001 100 070
Sample-0008 001 342 310
Sample-0009 001 401 370
Sample-0010 001 3.09 280 15
Sample-0011 001 199 170

Ideal

= Current
Proposed

O Included
Included (selected)

X Excluded

Reference
5

Sample-0012 001 100 070 ° Excluded (selected)
Sample-0013 001 342 310 05 E
Sample-0014 001 401 370 a0 iy 20 25 a0 03 10
A n > < [ i) >
Use replicates as individual calculation points Predicted
Show replicates Graph content:  Predicted vs reference -
Accept the proposed adjustment Previous Next

The graph section displays the samples as dark blue dots on the gray
reference lines. The plot gives an overview of the correlation, the
bias, the slope and the presence of outliers.

In this example, predicted values are biased by -0.301. Correction of
the slope and mainly the intercept correct for this deviation between
predicted values and reference values.
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The table in the upper part of the window indicates the improvement
of the absolute accuracy and the relative accuracy as a result of the
correction.

Zoom in by pointing in the graph area and rolling the mouse wheel.
A zoomed in graph can be moved around by using click and drag.
Pointing on a sample in the list displays the sample in orange in the
graph. Remove a sample from the calculation by unticking the sam-
ple in the # column of the list.

3 Check Accept the proposed adjustment to accept the changes.

3.3.9 Specific functions for DS2500 Solid Analyzer

With the DS2500 Solid Analyzer, the average result of multiple sample
cups (cups per sample) and multiple positions within the sample (number
of subsamples) can be calculated.

To analyze multiple positions and cups, proceed as follows:
1 Go to the Methods section.

2 Select the method for which you want to configure the number of
cups and positions.

3 Go to the Summary tab. Select a sample vessel type that supports
this functionality.

Table 4

Sample vessel type Intended purpose
Large cup Subsample

Multiple cups per sample
Small cup moving Subsample

Multiple cups per sample
Small cup Multiple cups per sample
Slurry cup Subsample

Multiple cups per sample
No cup Multiple cups per sample
Multisample cup None
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Setting Groups

During the analysis, the expected number of cups is displayed in Vision Air
Routine:

Caffeine "~ Small cup v

When starting the analysis in Vision Air, the sample registration view is dis-
played as usual but the user is prompted for the next cup. Finally, the
mean result for the cups is displayed.

Multisample Cup
The Multisample Cup is supported with Vision Air 2.0.2.25.

To select trays in Vision Air Manager, proceed as follows:
1 Go to the Methods section.
2 Select the method for which you want to configure the tray.

3 Go to the Summary tab in the data window and make sure that the
Sample vessel field has the value: Tray.

4 Go to the Settings tab in the data window and select the menu
item Tray configuration.

5 Select a pre-defined tray from the drop-down list.

If a customized tray has been ordered together with Vision Air, a con-
figuration file is provided by Metrohm. Import this configuration file
by using the Custom tray configuration import.

6 Click on [Save] in the toolbar.

Calibrating the instrument in Vision Air Routine

2 different processes for instrument calibration are available. One process
uses the internal built-in wavelength filter. The other process uses the
external wavelength filter. For intensity corrections, the DS2500 Solid Ana-
lyzer uses the external reflection standard as reference standard. Only
external wavelength filters can be certified.
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The instrument must be running for 2 hours before starting the instrument
calibration. For external instrument calibration, have the corresponding
external wavelength filters ready.

1 In Vision Air Routine, go to the Tools section.

2 Click on [Instrument calibration].

A window opens that prompts the user to enter the PIN code.

3 In non-pharma versions of Vision Air, enter your PIN code. The
default PIN code is 1234. Click on [OK].

In pharma versions of Vision Air, the user rights define whether a
user has access to instrument calibration. No PIN code is required.

The Instrument calibration window opens.

Instrument calibration

@® Use internal wavelength filter

(O Use external wavelength filter

4 Select whether to use the internal wavelength filter or the external
wavelength filter.

Click on [Continue] to proceed.

5 Click on [Calibrate].
The instrument is calibrated.

A message confirms the successful calibration. The instrument is
ready to measure samples.

3.3.10 Specific functions for DS2500 Liquid Analyzer

With the DS2500 Liquid Analyzer, multiple sample vessels are available to
address different sample absorbance levels and to enable a convenient
operation of the instrument.

To analyze multiple sample vessels and positions, proceed as follows:

1 Go to the Methods section.
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2 Inthe Method structure window, select the method for which you
want to configure the number of sample vessels and positions.
3 Go to the Summary tab.

Select a sample vessel type that supports the desired functionality
from the Sample vessel drop-down list.

Table 5

Sample vessel type Intended purpose
Disposable vials One-time use

No sample vessel cleaning
Cuvettes High precision measurements
Flow cell cuvette Automatization
Transmission wavelength stand- | External calibration of the
ard instrument

Heating and cooling the sample

¥ Extensions

Setting groups

Analysis o Is used to define settings specific for the DS2500L,

Automatic export and print

Automatic start control Check sample vessel type:
Check-sample operating procedure Temperature control:
Display options Equilibrium Temp (*C): 30,00000

Delay before scanning (seconds): | 0
Repetitions.

Sample numbering

Storage options

The DS2500 Liquid Analyzer supports a temperature range between 25 °C
and 80 °C. The minimum temperature that can be set must be 10 °C
above the ambient temperature T,in = Tampient + 10 °C

To achieve a temperature of 25 °C, the ambient temperature must be
15 °C. As the ambient temperature in most laboratories is approx. 25 °C,
Metrohm recommends to set the temperature to a minimum of 35 °C.

To define the target temperature during an analysis, go to the Methods
section in Vision Air Manager. Go to Settings » Liquid setup. Enable
Temperature control. Enter the desired temperature in Equilibrium
Temp (°C).

A delay before starting a scan ensures that the sample has the same tem-
perature as the sample holder. To define a delay before each scan, go to
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the Methods section in Vision Air Manager. Go to Settings » Liquid
setup. Enter the desired length of the delay in Delay before scanning
(seconds).

Temperature correction

If you set a sample temperature, the sample holder is heated or cooled to
this temperature. There may be slight differences between the tempera-
ture of the sample holder and the temperature of the sample.

To correct the sample temperature, proceed as follows:

Temperature control must be enabled for the method that is linked to
the operating procedure in use.

1 Go to the Tools section. Click on [Temperature correction].

A window opens that prompts the user to enter the PIN code.

2 Enter your PIN code. The default PIN code is 1234. Click on [OK].

The Temperature correction wizard opens.
3 Click on [Start] to proceed.

4 Follow the instructions on the appearing window.

Then click on [Next] to proceed.

5 Enter the desired sample temperature. Click on [Save].

A confirmation window appears.

6 Click on [Close] to exit the wizard.

Temperature correction is applied to the sample.

Measurement with open lid

It is possible to measure a sample while the lid of the DS2500 Liquid Ana-
lyzer is open.

Automatic start

If Automatic start is enabled, then the measurement starts automatically
as soon as the lid is closed.

1 InVision Air Manager, go to the Methods section.
2 Go to the Settings tab.

3 Open the setting group Automatic start control.
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4 Enable Automatic start.
The measurement starts as soon as the lid is closed.

After the measurement, the lid opens automatically.

Calibrating the instrument in Vision Air Routine

The DS2500 Liquid Analyzer is calibrated with an external wavelength
standard (see "Calibrating the instrument with an external wavelength
calibration standard”, page 83) and with an internal wavelength stand-
ard (see "Calibrating the instrument with an internal wavelength stand-
ard", page 84).

The external calibration is usually carried out by a regional Metrohm serv-
ice representative during the start-up of the instrument. If necessary, the
external standard can also be obtained separately (article number
6.7494.000). The user can repeat the external calibration if needed. Only
external wavelength filters can be certified.

The internal calibration uses the internal built-in wavelength filter. Carry
out the internal calibration once a different type of sample vessel to the
one used in the previous measurement is inserted. The path length is rele-
vant. Carry out an internal calibration after a DS2500 Holder for 2 mm
disposable vials was replaced with a DS2500 Holder for 8 mm disposable
vials, for example.

For intensity corrections, the DS2500 Liquid Analyzer uses air as reference
standard.

/\ WARNING

Hot surface

Danger of burning due to hot components. The sample holder can be
heated to a maximum of 80 °C. After operation, the sample compart-
ment, the sample holder and the sample vessel are very hot.

= Wear protective gloves when handling sample holders and sam-
ples.

Calibrating the instrument with an external wavelength
calibration standard

Accessories
= DS2500 liquid wavelength calibration standard (6.7494.000)

Precondition
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» The instrument must be running for 2 hours before starting the instru-
ment calibration. For external instrument calibration, have the corre-
sponding external wavelength filters ready.

1 Using the wavelength calibration standard

Place the wavelength calibration standard in the sample compart-
ment.

Optionally place the cover plate on the sample compartment. If
the sample holder is heated, the cover plate protects the user
from the heat that is generated.

Tighten the screw.

2 Calibrating the instrument

In Vision Air Routine, go to the Tools section.

Click on [Instrument calibration].

A window opens that prompts the user to enter the PIN code.
Enter your PIN code. The default PIN code is 1234. Click on [OK].
The Instrument calibration window opens.

Instrument calibration

O Use internal wavelength filter

@ Use external wavelength filter

Select Use external wavelength filter.

Click on [Calibrate].

Follow the instructions on the appearing window.

The wavelength filter is heated up to 50 °C automatically.

The instrument is calibrated.

A message confirms the successful calibration. The instrument is
ready to measure samples.

Calibrating the instrument with an internal wavelength
standard

Accessories

= Sample holder

Precondition
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= The instrument must be running for 2 hours before starting the instru-
ment calibration. For external instrument calibration, have the corre-
sponding external wavelength filters ready.

1 Inserting the sample vessel

» Define with which sample vessel the next measurement is to be
carried out.
» Insert the selected sample vessel.

If an incorrect sample vessel was inserted for the calibration
with the internal wavelength standard, the error auto lineari-
zation failed may be displayed during the routine analysis.

2 Calibrating the instrument

= In Vision Air Routine, go to the Tools section.

» (Click on [Instrument calibration].
A window opens that prompts the user to enter the PIN code.

= Enter your PIN code. The default PIN code is 1234. Click on [OK].
The Instrument calibration window opens.

Instrument calibration

@® uUse internal wavelength filter

O Use external wavelength filter

Select Use internal wavelength filter.
Click on [Calibrate].

The instrument is calibrated.

A message confirms the successful calibration. The instrument is
ready to measure samples.

3 Repeating the calibration

Once a sample vessel with a different path length has been inserted,
repeat the internal calibration. To do this, start with Step 1 again.

3.3.11  Specific functions for XDS MasterLab

Two measurement modes are possible with the XDS Masterlab Analyzer.
On start-up of Vision Air Routine that is connected to an XDS Masterlab
Analyzer, you are asked which mode to use.

To start up Vision Air Routine, choose between Reflectance mode or
Transmission mode.
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To move trays manually in Vision Air Routine, proceed as follows:

In Vision Air Routine, the tray can be moved to different positions.
1 Go to the Tools section.

2 Select 1 of the following options to move the tray manually.

Tray

53] Move to transport position
133] Move to tray position
[#] Move to XDS iris position

-1 Move to boat position

To select trays in Vision Air Manager, proceed as follows:
1 Go to the Methods section.
2 Select the method for which you want to configure the tray.

3 Go to the Summary tab in the data window and make sure that the
Sample vessel field has the value: Tray.

4 Go to the Settings tab in the data window and select the menu
item Tray configuration.

5 Select a pre-defined tray from the drop-down list.

If a customized tray has been ordered together with Vision Air, a con-
figuration file is provided by Metrohm. Import this configuration file
by using the Custom tray configuration import.

6 Click on [Save] in the toolbar.
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3.3.12 Specific functions for XDS MultiVial
To move trays manually in Vision Air Routine, proceed as follows:

In Vision Air Routine, the tray can be moved to different positions.
1 Go to the Tools section.

2 Select 1 of the following options to move the tray manually.

Tray

%52 Move to transport position
#28 Move to tray position
E’E Move to XDS iris position

B-1 Move to boat position

To select trays in Vision Air Manager, proceed as follows:
1 Go to the Methods section.
2 Select the method for which you want to configure the tray.

3 Go to the Summary tab in the data window and make sure that the
Sample vessel field has the value: Tray.

4 Go to the Settings tab in the data window and select the menu
item Tray configuration.

5 Select a pre-defined tray from the drop-down list.

If a customized tray has been ordered together with Vision Air, a con-
figuration file is provided by Metrohm. Import this configuration file
by using the Custom tray configuration import.

6 Click on [Save] in the toolbar.
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3.3.13 Specific functions for XDS RapidLiquid

The RapidLiquid Analyzer supports a software controlled heating function-
ality.

To define temperature control and blank correction, proceed as follows:
1 Go to the Methods section.
2 Select the method to configure the temperature control.

3 Go to the Settings tab in the data window and select Liquid
setup.

4 Define your settings for temperature control and blank correction.

If blank correction is activated, the user is guided through the process
of blank correction in Vision Air Routine.

Blank correction, correcting the effect of the used sample holder,
has to be conducted once before the first measurement.

3.3.14 Specific functions for XDS SmartProbe and XDS Interactance
Probe

Reference scan

Reference measurements with the XDS SmartProbe and the XDS Interac-
tance Probe are conducted by placing the probe into the respective posi-
tion of the instrument. Whenever a reference measurement is needed, the
user is informed in the information field of Vision Air Routine.

Probe

Reference measurement

Place the probe in the reference
position and pull the trigger.

The time period between individual reference scans can be set in Vision
Air Manager. The maximal time period is 60 minutes.

A permanent installation of the probe into a system is not sugges-
ted due to maximum validity of a reference scan of 60 minutes.



4 Installation

4.1 Vision Air Server

4.1.1 System requirements

Installation

Table 6  Vision Air Server

Operating system

Windows Server 2012 R2 Full Edition with Service
Packs / Windows Server 2016 / Windows Server
2019

Operating System Language must be English
(during installation only)

CPU

Dual 2 GHz processors

Memory (RAM)

8 GB

HDD

80 GB free space (dependent on data storage
needs)

NTFS File System

Video

SVGA at 1024x768, 16 bit color

NIC

1 Gbit Ethernet

Database Server

Microsoft SQL Server 2014 /2016 /2017

Connectivity

2-5 open ports on firewall (Incoming). The num-
ber of ports depends on the instrument type and
proxy server configuration.

External IP address or DNS address (recommen-
ded) for external clients to be able to communi-
cate with the Vision Air Server.

SMTP account for emailing reports and Vision Air
Manager download links (optional).

Additional software
and requirements

Internet Information Services (IIS) Server role
.NET 4.8 Framework Extended
Crystal Reports 13.01 runtime (included)

MATLAB Compiler Runtime 8.0 (installed sepa-
rately)

E All needed software can be found on the provided DVD.
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4.1.2 General information Vision Air Server

Microsoft SQL Server

Vision Air Server uses the Microsoft SQL Server for all data storage (see
"System requirements”, chapter 4.1.1, page 89). SQL Server Management
Studio is required for the initial configuration of the Microsoft SQL Server
(see " Configure SQL Server ", page 93). Purchase and install Microsoft
SQL Server and SQL Server Management Studio separately. Metrohm does
not supply Microsoft SQL Server.

Communication protocols

Communication between the Vision Air Server and Vision Air clients is
based on WCF and TCP or HTTP and is encrypted with a SSL certificate.
The HTTP version is intended for use only by customers with Proxy servers
that limit TCP communications.

DNS URL Address

A DNS address is recommended in order for Vision Air clients to locate
and communicate with the Vision Air Server. Please contact your IT
department for the DNS URL prior to beginning the installation process,
e.g. VisionAir.yourcompany.com.

H The Vision Air clients can also connect using an IP address but each
instrument will need to be reconfigured if the IP address ever
changes. Use of a DNS URL Address will allow for changing the
Vision Air Server IP address without reconfiguring each instrument.

SSL Certificate

Communication between the Vision Air Server and clients is secured using
a SSL certificate installed on both the Vision Air Server and the client PC.
Metrohm NIRSystems provides a SSL certificate during the Vision Air Server
installation.

A custom SSL certificate, e.g. VisionAir.yourcompany.com, may be used
instead of the one provided by Metrohm NIRSystems. There are no
requirements for custom certificates other then it must not be expired.
Communication between the Vision Air Server and clients cannot occur if
the SSL certificate is missing or expired.

SMTP

The Vision Air Server uses SMTP for emailing installation links to users to
assist in the installation of Vision Air Manager Network (see "Distribution
of the Vision Air Manager Network", chapter 4.2.2, page 116). Vision Air
Server can also be configured to email scheduled surveillance reports to
instrument managers.
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Both features are optional and will require an SMTP Server, a SMTP port
and a user name and password (when anonymous relaying is prohibited).

Computer virus prevention

Metrohm NIRSystems recommends that our customers maintain continu-
ous protection of their computers and network infrastructure from threats
posed by computer viruses, worms, and other types of hostile computer
programs.

This can be implemented by installing and frequently updating an appro-
priate anti-virus program on the PCs and connecting the PCs in @ minor
closed network.

Protection against computer viruses is solely the responsibility of the cus-
tomer and Metrohm NIRSystems can not be held responsible for any dam-
age these types of programs may cause including lost and corrupted data
or data theft.

Server ports

Vision Air Server Vision Air Database

Vision Air Routine

oe

Ir

Vision Air Manager
_./’“\
‘\"/

@ CLIENT-SIDE PORTS: Communication is always initiated from the cli-
ent. The same ports opened on the Vision Air Server must be open
for outgoing traffic on the client. The ports do need to be opened
on the client (or external client site) for incoming communication.

Vision Air SQL database can be hosted

externally to the Vision Air Server. Default

SQL port is used. If using a remote database

you must:

a) create a SQL accout for Vision Air or

b) grant access to the machine account you
running Vision Air.

Please contact your IT department for any firewall port issues. Met-
rohm NIRSystems cannot make any changes to your firewalls.

Table 7
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Port A: Required standard port
for TCP communication with
Vision Air Server (Vision Air cli-
ents).

Port B: Alternative port for HTTP
communication with Vision Air
Server (Vision Air clients).

Port C: Required HTTP port for
ClickOnce installation and update
of Vision Air Manager clients.

E-mail account: Vision Air has
features for generating and send-
ing e-mails to users. Such e-mails
are sent from the Vision Air Server
which in that case needs to be
configured with a SMTP Relay
agent (not mandatory).

Client and instrument ports:
Communication is always initiated
from the Vision Air client and the
instruments. The same ports
opened on the Vision Air Server/

Port numbers: Metrohm recco-
mends using ports in the 8000
range to reduce potential interfer-
ence by other applications. The
port range can be changed to

firewall must be open for outgo- meet the customer's needs.
ing traffic only on the clients and

instruments.

4.1.3 Pre-installation

The Vision Air Server setup does not upgrade Microsoft SQL Server
installation.
Vision Air Server installations connected to Microsoft SQL Server

2012 should be migrated to Microsoft SQL Server 2014 prior to
upgrading to Vision Air Server 2.0.7.

SQL Server maintenance plans

Metrohm NIRSystems strongly recommends the use of SQL Server mainte-
nance plans in order to keep Vision Air performing at peak performance
and to prevent issues that normally occur through the long-term usage of
any database.

At a minimum the following maintenance plans should be created and
scheduled to run weekly:

» Database integrity
» Rebuild indexes
» Update statistics

Please consult the local IT department for assistance in creating the SQL
Server maintenance plans.

SQL database backups and maintenance

It is the customer's responsibility to backup and safeguard the Vision Air
data from loss. Metrohm NIRSystems cannot be held liable for data loss.
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Metrohm NIRSystems strongly recommends that the Vision Air Server SQL
database is backed up on a reoccurring and timely schedule, at a mini-
mum daily, in order to safeguard the data from loss. This can be done by
using any software capable of performing full system backups, full system
snapshots or SQL Server backups. The Vision Air Server software does not
contain any backup functionality.

Additionally, it is recommended that each SQL Server have an automated
SQL maintenance plan to help ensure the health and optimization of the
SQL Server. Please consult the local IT department for assistance in creat-
ing SQL maintenance plans.

SQL Server configuration

E Before you begin to install Vision Air Server, purchase and install
Microsoft SQL Server and SQL Server Management Studio sepa-
rately. Metrohm does not supply or install SQL Server.

Configure SQL Server

1 Open SQL Server Management Studio.

2 Connect to SQL Server instance created during SQL Server Installa-
tion.

3 Right-click on the SQL Server instance and select New Query.

\Q Micresoft SQL Server Management Studio

File Edit WView Debug Tools Vindow Commun
_:J__NEVJQUEFF |_-|";_=| E’é,__;.":" = __P_Sje i

Connect~ &3 &1 w T ] &5 |
T —
ERFY . \S0LEXPRESS I ER
[ [ Databases
H 3 Security Disconnect
[# [ Server Obj Register...
[# [ Replicatio
[+ (4 Manageme Mew Query
Activity Monitor
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4 = Enterthe query:
Sp_configure 'show advanced options', 1,
GO
RECONFIGURE;
GO
Sp_configure ‘clr enabled’, 1;
GO
RECONFIGURE;
GO
= Click on [Execute]

E&i 89 ‘19z | master * (¥ Execute b

~'SQLQuery3.sql ...CO8' josv (75))* | —
sp_configure 'show advanced options', 1;
GO
RECONF IGURE ;
GO
sp_configure 'clr enabled', 1;
GO
RECONF IGURE ;
GO

The results should display that the query was executed successfully
with a message similar to the one below.

I3 Messages I

Configuration cpticn 'show advanced options' changed from 0 to 1. Run the RECONFIGURE stavement to install. &
Configuration opticn 'clr enabled' changed from 1 to 1. Run the RECONFIGURE statement to install.

4| I;ILI

@ Query executed successfully, mosaic0d (10,50 RTM) | MOSAICOS\josy (65) | MosaicTraining | 00;00:00 | 0 rows

SQL Server Login Permissions

This section only applies if the SQL Server is installed on the same physical
device as the Vision Air Server software.

If SQL Server is installed on a separate server, see Remote SQL Server con-
figuration, chapter 4.1.4, page 97.

41 Open SQL Server Management Studio.

2 Connect to SQL Server instance created during SQL Server Installa-
tion.
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3 Expand Security » Logins. Right-click on NT AUTHORITY\SYS-
TEM » Properties. If this login is not existing, create a login (see
"Create the Login", page 96).

4 Click on Server Roles. Verify that public and sysadmin are selec-
ted (checked). If not, select them.

B Login Properties - NT AUTHORITY\NETWORK SERVICE =] B3
Selectapage 5 Seript + LY Help

Server role is used to grant serverwide security privileges to a user.
22 Securables
2 Status el
[] bulkadmin
[ dbcreator
[] diskadmin
[ ] processadmin
public
[[] securityadmin
"] serveradmin
setupadmin
sysadmin
| Connocion
Server:
\SQLEXPRESS
Connection:
ME-HERISAUsrv-visionair
2§ View conneclion properties
Ready

(o ] _com |

=

5 Click on User Mappings. Verify that the Database master is selec-
ted and the roles are db_owner and public.
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- NT AUTHORITY\NETWORK SERVICE

=] E3

Default Schema

o Serit - Iy belp
Users mapped to this login:

*Map I Database I User
i master NT AUTHORITY\NET.
r mode!
r
O msdb
™ tempdb
) VisionAr
O VisionAir2

[ Guest account enzbled for: master

Database role membership for: master

Conneclion \ [ db_accessadmin
[] db_backupoperator
Server
\SQLEXPRESS [[] db_datareader
[ db_datawriter
Connection [] db_ddladmin
ME-HERISALMsnv-visionair [ db_denydatareader

db_denydatawriter

3d Mew connection properties

public

Ready

6 Click [OK] and exit.

Create the Login

1 Right-click on Logins » New Login....

2 Create a new user.



Object Explorer

Connect~ 3 &) m T (2] .5

= [ Databases

= 3 Security
=] Logins
&, =
&, #8
A NT
& NT
& NT

& NT

& sa

]

&

=

= [_a WIN-5H74 QLIUK35\SQLEXPRESS (SQL Server 11.0.2100

[ [ System Databases
@ | J ReportServer$SQLEXPRESS
@ | J ReportServerSSQLEXPRESSTempDB

& NT

New Login... P
Filter »

Start PowerShell RESS
Reports »
Refresh T

& NT-AUTORITAT\SYSTEM

%) VORDEFINIERT\Benutzer
A WIN-5H74QLIUK35\Metrohm
& 3 Server Roles
@ @ Credentials
# L3 Server Objects
| [_J Replication
| [ Management

4.1.4 Remote SQL Server configuration
This chapter describes the installation procedure if the SQL Server and the

Vision Air Server are installed on different hardware devices.

Configuring the SQL Server

Allow remote connection to the SQL Server

1 Open SQL Management Studio and log in.

2 Right-click on the server name and select Properties.

Installation
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I; Microsoft 5QL Server Management Studio
File Edit WView Debug Tools WWindow Community Felp

: Dl NewQuery | jy [ L |5 H & | B o
Object Explorer

- ME-HERISAL\srv-visionair)

H (3 Dat Connect...
# L3 Sea Disconnect
L3 Ser Regster,..

3 Rep :

L3 Mar Mew Query
Activity Monitor
Start

Stop

Pause

O e
rESUME

Restart

Palides 3

Facets
Start PowerShell

Reports k

Properties
'{)ﬁ

"‘l\q.b-_____d.pﬂ"

3 Select the Connections page and place a check in Allow remote

connections to this server checkbox. Click [OK].



! F Server Properties - SRV-VISIONAIRT\SQLEXPRESS _ (O] =]
.  page L5 Scipt + [ Help

Installation

&7 ermissions

Connections

Maximum number of concument connections (0 = unlimited):
0 33
™ Use queny govemor to prevent long-unning queries

Default connection options:

[] implicit transactions

[] cursor cloge on commit
[] ansi wamings

[] ansi padding

[ ANSINULLS

[] arthmetic abort

[] arthmetic ignore j
ote server connections
s\ES%T_rD(PRESS v Alow remote connections to this server
Remote guery timeout (in seconds, 0 = no timeout):
Connection
ME-HERISAU"\srv-visionair 600 3:
24 MView connection proerties ™ Require distributed transactions for servero-server communication
Re
ady ' Corfigured values " Running values
coes
4

Close SQL Management Studio.

ClickStart » Administrative Services » Services.

Verify the SQL Server Browser service Startup Type is Automatic
and Status is Started.

* ASOL Server Brawser

Provides 5..,  Started

Automatic

Local Service

Verify the Distributed Transaction Coordinator service Startup

Type is Automatic

* XDistributed Transaction Coordinator

and Status is Started.

Coordinate,.. Started

Automatic (D...

Configure DTC on the SQL Server to allow inbound transactions:

» Click Start » Administrative Tools » Component Services.

= Expand to locate Local DTC. Right-click on Local DTC and select

Properties.

Metwork S,

29
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4, Component Services

. File  Action  Wiew  ‘Windaw Help

&= 7E|E =

|:| Consoe Root
g & Cermponent Services
= | Computers
= 18l My Computer
F | CoM4+ Applicakions
|| DM Config
|| Running Processes
= || Distributed Transaction Coordinakar
Lol Local DTG
{4 Event Viewer (Local)
L Services (Local)

Wi k
Mew Window From Here

Expott Lisk, .,

Propetrties

Help

= (Click on the Security tab.
Place a check in Network DTC Access and Allow Inbound.

LocalDTCPoperties B
Tracing I Logging  Security |

(FOECUMy Settngs
I+ Metwerk DTC Access

e Administration
[ Aldw Bemote Clierts [~ Allow Remote Administration

er Communication
: [™ Allow Outbound
% Mutual Authentication Reguired

" Incoming Caller Authentication Required

" Mo Authertication Required

[™ Enable ¥4 Transactions ¥ Enable SMA LU 6.2 Transacions
—DTC Logon Account

Accourt: INT AUTHORITY \Metwark Service Browse. . |
Paszword |

Confirm password: I

Leam maore about getting these properties.

[ ok | Ccancel Apply
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= In case of cross-domain setup select No Authentication
Required.

» Click [OK] and close Component Services.

= Restart all the SQL services.

To check if DTC is working there are several options:

= Use DTCTester (tool from Microsoft).
» Use SQL Management Studio to try to create distributed transac-
tions if you have a local SQL Server.

Enable TCP/IP protocol in SQL Server Configuration Man-
ager

1 ClickStart » All Programs » Microsoft SQL Server
2008 » Configuration Tools and select SQL Server Configura-
tion Manager.

2 Expand SQL Server Network Configuration.

3 Highlight Protocols for SQL Server Name.

4 Right-click on TCP/IP and select Enable.

‘@ SGL Server Configuration Manager {Local) Protocol Name | Status
g S0L Server Services % Shared Memory Enabled
& S0L Server Network Configuration (32bit) med Pipes Disabled
= S0L Mative Client 10,0 Configuration (32bit)
B B 500 Seruer Netwnrk Ennﬁgllrao Hvia Enable
= Protocols for SQLEXPRESS Disable
% SQL Mative Client 10.0 Configuration N
Properties
Help

5 Click [OK], close the SQL Configuration Manager and restart the
SQL services.

I"'-_-' | Any changes made will be saved; hawever, they wil nat Eake
L effect until the service is stopped and rastarted.
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Grant access to the Vision Air Server Account

To connect using a Windows account:

1 Select if a machine account or a user account will be used:

= <domain>\<machine>$ (like “DOMAIN\VISIONAIRPCS") or
»  <domain>\<accountname>

2 Onthe SQL Server open SQL Server Management Studio and log
in.

3 Expand Security and right-click on Logins and select New Login.

l,: Microsoft SQL Server Management Studio

File Edit View Debug Tools Window Community Help
i NewQuery | gy | L | B H & | M o

Connect~ &J 32 m T E __:,_s

= Lﬂ NSQLEXPRESS (SQL Server 10,50, 1617 - ME-HERISAL\srv-v sionair)
1 Databases

O =3 Sccurity
B
Mew Login... L ogin##
Filtzr T
Stert PowerShell
RVICE
Reports »
. F55
ReTesh

4 On the General page click [Search] to locate and add the Windows
account which will communicate with the SQL Server (machine or
user account).
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5 Click on Server Roles page and place a check next to dbcreator

6

E Login - New

electa page
5 General

=" Server Noles
2 User Mapping
% Secursbles
A Status

Server:

ASQLEXPRESS
Connection

ME-HERISAL srv-visionair

4 View connection properties

Installation

1S[=] B3
5 Scipt + [ Help
Logi neme: I —  Search

£+ Windows althentication
£ 5QL Server authentication

Password: I

Confirm password: |
(5l Specify old pessword

Old password: |
F Enforce password policy
¥ Erforcs pessword expirstion
¥ Usermust change password &t nexd login
" Mapped to cettficate |
" Mapped to asymmetric key |
I™ Man to Credertial [

L | L L]

Add
Mapped Credertials Credential | Provider
Remove
Defaul database: |master |
Default language: |<de{au|t> j

and public.

E Login - New

2 Securables
A Status

Server:

\SQLEXPRESS

Connection:
WMF-HFRIS Al I'srv-visinnair

23 View connection properties

Progress
Ready

=] 3
L5 Serpt + [ Help

Server mle is tised o gt server-wide seciity privileges fo A user

Server roles:
g || bulkadmin

|

[] diskadmin
[] processadmin
[w| public

|| securtyadmin
] serveradmin
[ setupadmin
] ayaadmin

ok ] o |,

If the database already exists, click on User Mapping page. Add a
check next to the database name and then db_owner and public in

the role membership pane.

103



104

Vision Air Server

7 Click [OK] and exit SQL Server Management Studio.

Server:

MSQLEXPRESS
Connection:

ME-HERISAU srv-visionair

!; Vigw connection properties

E—

Ready

L5 Scrigt - [y Help

[[=] B3

Users mapped to this login:

Map | Database

|U5er

| Default Schema

O master
model
Mogaic
medb
tempdb
VisionAir
VisionAir2

I | Guest sooourt enabled for: VisionAir

Database role membership for: Vision Air

[] db_accessadmin

b_ddladmin

d
db_denydatareader
db_denyd

o | el |

Connect using a SQL account

1 Open SQL Server Management Studio and log in.

2 Right-click on the server name and select Properties.
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B Microsoft SQL Server Management Studio

A

File Edit WView Debug Tools Window Community Help

DiNewQuery | |5y | Lh |5 H S | & o

Connect...

— Security Disconnoct
[+ __,| Ser\r.er ijects Bl
[+ _J Replication

[+ _J Management Mew Query

Activity Monitor

Start
Stop
Pause
Resume
Restart

Policies 3

Facets
Start PowerShell

Reports F

3 Click on the Security page. Enable SQL Server and Windows
Authentication mode radio button. Click [OK].
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1
B Server Properties - SRV-VISIONAIRT\SQLEXPRESS | _ (O] x|
: 5 Seript - [ Help
12 General
127 Memory
jr-.} Server authentication
T Connections " Windows Authertication mode
A 2
I Databese Seftinge ' 5QL Server and Windows Authertication mode
124 Advanced
27 Pemissions
Login suditing
 None

+ Failed logins onfy
" Successful logine onty
™ Both failed and successful logins

Server proxy account
I Enable server proxy account
Proxy account: | 3
Password feeess
echon

Server: R

MSQLEXFRESS

Connection: ™ Enable C2 audit tracing

ME-HERISAU \srv-visionair

Cross database ownership chainin:
4 View connection properies L % &

Progress
Ready

Cares

A

Expand Security and right-click on Logins and select New Login.

"v: Microsoft SQL Server Management Studio

File Edit WView Debug Tools Window Community Help

t DI NewGuery | [y | [y | H & | B -

Connect~ 3 31 m F [&] ;
= L.ﬂ NSOLEXPRESS (SQL Server 10,50, 1617 - ME-HERISAL \srv-visionair)
[ Databases

B L3 Security
=53
Mew Login... login##
HE
Filter S
Start Powershell
RVICE
Reports b
: ESS
Refresh

On the General page

= Enter Login name.

«= Select SQL Server authentication.

= Enter and confirm the password.

= Deselect Enforce password expiration.
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E Login - New M=l E3
Selectansge % Seript ~ [} Help
#A General
= Cerver Mgt
2 User Mapthg Login pame: sl Vision ArSQL User Search..
1 Scourablea © Windows authelicalion
7 Status *\ i)
== * SQL Server authentication
Password |uuuu
Corfirm password: |uuuu
|} Specify old password
Old password: |
¥ Enforce password policy
| :
5| Usermust change password at next login
" Mapped to cetficate | -
" Mapped to asymmetric key | =l
™ Map to Credential I j Add|
Mapped Credertials Credeid (s |
Server:
MNSQLEXPRESS
Connection:
ME HERISAU arv visienair
3¢ Mew connection properties
Roatly Default database: |maste( LI
Defauit language: [<cefaut> =

6 Click on Server Roles page and place a check next to dbcreator

and public.

E Login - New

erver Roles |
[ User Mapping
% Secursbles
5 Status

Server:

ASQLEXPRESS
Connection

ME-HERISAL srv-visionair

94 View connection properties

;

Ready

1[=1 E3
st - L3vob

Server role is used to grant server-wide security privileges to a user.

Server roles
[] bulkkadmin
dbcreator
[] diskadmin
[] processadmin
vl public
[] securtyadmin
[] serveradmin
[] setupadmin
[] sysadmin

(o] o |

i

If the database already exists, click on User Mapping page. Add a

check next to the database name and then db_owner and public in

the role membership pane.
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1[=] B3
‘;S Script -+ Ef] Help
= Server HU‘?S Server role is used to grant servewide secuity privileges to a user.

1 User Mapping

[ '@' Securables

=7 Status Server roles:
[ bullkadmin
el
[ diskacmin
[[] proceszadmin
[w] public
[ zecurilyadmin
[[] serveradmin
[[] setupadmin
[ sysadmin

Server

FOS523MMOSAICTESTSRY

Coanection:

FO35405Y

Y ¥iew connection properties
Ready

A

e

g Click [OK] and exit SQL Server Management Studio.
Configuring the Vision Air Server

Allow Outgoing Communication

To install the SQL Server and Vision Air Server on different hardware devi-
ces, carry out the following steps during the SQL Server installation.

1 Click on Start and search for Services.

2 Verify the Distributed Transaction Coordinator service Startup
Type is Automatic and Status is Started.

Coordinate... Started Automatic (D... Metwork S...

* ANistributed Transaction Coordinator

3 Configure DTC on the SQL Server to allow outbound transactions:

= Click on Start and search for Services.

= Expand to locate Local DTC. Right-click on Local DTC and select
Properties.

= (Click on the Security tab.
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% File  Action  View  Window Help

&= 2m0=H=
(L1 Consale Root
= o M Campanent Services
= || Computers
= & My Comouker

&[] QoM+ Applications

H [ ] DCamM Config

[# || Ruming Processes

=

Wiew 4

& . Services (Local) Mew W' ndow From Here

Expork List. ..

Properties

Help

= Place a check in Network DTC Access and Allow Outbound.

» In case of cross-domain setup select No Authentication
Required.

» (Click [OK] and close Component Services.

Local DTC Properties |

' Tracing I Logging Security I

— Security Settings
¥ MNetwork DTC Access

r Client and Administration
[~ Allow Remote Clients ™ Alow Remote Administration

r~ Transaction Manager Communicatior
™ Blow Inbound M
¢ Mutual Authentication Required
" Incoming Caller Authentication Requined

| Mo Authentication Required |

[ Enable XA Transactions W Enable SNA LU 6.2 Transactions
—DTC Logon Account

Account: INT AUTHORITY \Network Service Browse...
Password: I

Confimm password: |

Leam more about getting these properties.

[ ok | cancel Aoply

» Restart the Vision Air Server.
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To check if DTC is working, there are several options:

« Use DTCTester (tool from Microsoft).
= Use SQL Management Studio to try to create distributed transac-
tions if you have a local SQL Server.

Fix dependency to SQL service

To install the SQL Server and Vision Air Server on different hardware devi-
ces, carry out the following steps during the Vision Air Server installation.

Configure a Vision Air Service so that it does not depend on SQL Server,
but only on Distributed Transaction Coordinator.

1 Open a command prompt.
2 Type SC QUERY and then press [Enter].
3 Scroll through the list and make note of the Vision Air Service name.

If the list is truncated, then export the list. Type "SC Query > serv-
ices.txt". Go to the respective folder and open the .txt file.

SERVICE_MAME: Uision fAir Server (UVISIONAIR>
DISPLAY_NAME: Uision Air Server <(UISIONAIR>
: 18 UWIN3Z2_OUWN_PROCESS
STATE = 4 RUNNING
(STOPPABLE. WOT_PAUSABLE. ACCEPTS_SHUTDOWN)

WIN32_EXIT_CODE : B (Bx@>
SERVICE_EXIT _GODE : @ (Bx@8)
CHECKPOINT : BxB
WAIT_HINT s

4 Get the configuration of Vision Air Service by typing SC QC “Vision
Air Service name" and press [Enter].

| C\WINDOWS\system32\cmd.exe

C:s\Userssspv—visionairr’sc gc "Uision Air Server (UISIONAIR>"
[SC]1 QueryServiceConfig SUCCESS

SERUICE_NAME: Uision Air Server C(UISIONAIR>

TYPE : 18 WIN32_OWN_FROCESS

START_TY¥FE 2 AUTO_START

ERROR_CONTROL g NORMAL

BINARY_PATH_NAME 8 =sProgram Files OdB6>\MetrohmUizion Air~UISIONAI
RNUISTONAIR“Hosting.exe'" /& ce

LOAD_ORDER_GROUP

DISPLAY_NAME : Uision Air Server (UISIONAIR>
DEPENDENCIES : MSDIC

: MESOLSSQLEXFRESS
SERVICE_START_MAME : LocalSystem

C:sUserss\srv—visionair}

5 Remove the SQL Server dependency and leave the Distributed
Transaction Coordinator dependency type SC CONFIG “Vision Air
Service name" and press [Enter].

C:sUsersssru-visionairdsc config "Uision Air Server C(UISIONAIRY' depend= MEDTC
'

[SC] ChanaeServiceConfia SUCC
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6 10 verify the SQL Server no longer appears under dependencies type
SC QC “Vision Air Service name" and press [Enter].

To configure the Vision Air service to depend on SQLEXPRESS
and Distributed Transaction Coordinator: sc config “Vision Air
Service name" depend = MSDTC/MSSQLSSQLEXPRESS.

Configure access to SQL Server

Depending on the account used for SQL Connection, you may need to
configure Vision Air service to run as a specific domain account (which
needs to be an administrator on the Vision Air Server) or to modify host-
ing. exe.config for SQL Authentication.

If you are using SQL authentication then update Vision AirConnection-
String in hosting.exe.config so it looks like:

= Open C:\Program Files (x86)\Metrohm\Vision Ain\VISIONAIR\VISIONAIR
\Hosting.exe.config using Notepad.

= Search for MosaicConnectionString.

= Change the section after connectionString= to "Server=SERVERNAME
\sglexpress;Database=Vision AirXXX;pooling = false;User |d=USER-
NAME;Password=PASSWORD;Connection Timeout= 30",

= Vision AirXXX is the Service System Name of the Vision Air database.

= USERNAME is the SQL Login name set up in the previous section.

= PASSWORD is the password set for the SQL Login account.

= Verify the “ symbols are included and the line ends with\>.

4.1.5 Installation of Vision Air Server

Site preparation

= The Site Preparation Check List (8.105.8026EN) must be completed
before installation of any Vision Air component or interfacing software
program.

= Verify that the firewall has been updated to allow incoming and outgo-
ing traffic on new ports.

= Verify that DNS has been configured for Vision Air Server URL.

= Verify that the SSL certificate has been acquired and installed.

= Verify that the account used for installation is a full administrator
account.

System and database backup

Metrohm NIRSystems strongly recommends that a full system backup or
server snapshot is performed prior to running the Vision Air Server installa-
tion whenever upgrading the Vision Air software. In addition, it is strongly
recommended to create a full SQL database backup of the Vision Air data-
base before beginning the installation.
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Shut down all other programs on the computer.
Make sure that the Windows language is set to English.

Make sure that you are logged in to the PC with administrator rights.

1 Insert the installation medium with Vision Air installer and double-
click the installer for Vision Air Server.

2 Click on [Next].
3 Read and accept the license agreement. Click on [Niext].

4 Before Vision Air Server is installed, the program will first check
whether any necessary software components are missing on the PC.

The first time Vision Air Server is installed on a PC, all these software
components will be installed one after the other. Follow the on-
screen instructions and click on [OK] when prompted. When re-
installing Vision Air at a later stage e.g. when upgrading to later ver-
sions, most of these necessary components will already be installed
and the installation automatically skips these steps.

A reboot of the computer may be required during installation. If the
installer does not start-up automatically after the reboot, please dou-
ble-click the installer again.

5 Define the Service System Name and a Location for the new
Vision Air Server instance:

Table 8
Field Description
Location Define a folder in the file sys-
tem.
Service System Name Displayed name of the Vision
Air Server instance.

6 Click on [Install]
After successful installation, the Config Tool opens.

Installation log files can be found in the temp folder of your operat-
ing system. Open Windows Explorer and type in [%otemp%o]. In this
folder you will find a file named Vision_Air_DATE_TIME.txt.
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Configuration

1 The Config Tool is designed as a wizard, but each section can be
accessed directly as well.

Click on [Next] to go through the different windows.

2 Vision Air Server tab:

Table 9

Field Description

Vision Air Server DNS Name or | Define a network name.

IP address

Vision Air TCP port Defines the port number for
Vision Air Routine. This port has
to be open (firewall).

Vision Air HTTP port Alternative port when using a
proxy server.

Vision Air HTTPs port Alternative port when using a
proxy server.

ClickOnce port Used for installing Vision Air
Manager via network installer.

3 SQL Server tab:

Table 10
Field Description
Server Address Address of the server.
Server Instance Name <server name> <SQL instance
names.
Database Choose an existing database
catalog or define a new name.

4 Mail tab: Define e-mail server settings. Fields can be left empty if e-
mail service will not be used.

Table 11
Field Description
Mail server address Ask your local IT department,
e.g. mail.metrohm.com.

113



114

Vision Air Server

Mail server port Ask your local IT department,
e.g. 12.

Mail server user name Account that sends the auto-
matic mails.

Mail server user password Password of the account that
sends the mails.

5 License tab

Select the provided license file and click on [Next].

6 E If your server setup has no internet connection, refer to the
section Offline Configuration.

Install Service tab: Click on [Save and Restart Vision Air] to
complete the configuration process.

The server will now start up. After successful installation an icon will
be displayed in the Windows task bar.

Table 12
Icon Description
n Vision Air Server is starting up.
n Vision Air Server started suc-
cessfully and is ready.

7 |f desired, the Windows language can be changed again.

Offline configuration - Create a configuration package

1 Copy the Config Tool.exe from the Vision Air program folder to a
computer with internet connection.

2 Launch the Config Tool via command window with the following
command: ConfigTool.exe /Offline

Config Tool opens.
3 Go to the Vision Air Server tab.

4 Enter the server address of the target server.
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5 Enter the instance Name of the target instance. This MUST be identi-
cal to the name typed in the installer.

6 Fillin the port number as required.

7 Click on [Save package] and save the package on the file system.

Offline configuration - Load a configuration package

1 Copy the package file to the computer where Vision Air Server has
been installed (without internet connection).

2 Launch Config Tool.
3 Go to the Current settings tab.
4 Click on [Load package] and select the package on the file system.

5 Go to the Install Service tab.

Click on [Save and Restart Vision Air] to complete the configura-
tion process.

The server will now start up. After successful installation an icon will
be displayed in the Windows task bar.

Table 13
Icon Description
n Vision Air Server is starting up.
n Vision Air Server started suc-
cessfully and is ready.

With the installation of the Vision Air Server the Vision Air Manager Net-
work is installed. The Vision Air Manager Network is used to manage all
instrument configurations and data that was collected by the clients
(Vision Air Routine). Multiple Vision Air Manager Network installations can
be installed on different devices. See Distribution of the Vision Air Man-
ager Network on page 116, for information on how to distribute the
Vision Air Manager Network.
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4.2 Vision Air Manager

4.2.1 System requirements

Table 14  Vision Air Manager Network

Operating system Windows 7 Enterprise SP1 (32 & 64 bit)
Windows 10 (32 & 64 bit)
Windows Server 2012 /2016 /2019

Operating System Language must be English
(during installation only)

CPU 2 GHz processor

Memory (RAM) 2 GB

HDD 10 GB free space

Video SVGA at 1024x768, min. 16 bit color
(1280x1024 recommended)

NIC 1x 100 Mbit Ethernet

Firewall ports 2 firewall ports for outgoing communication

Additional software | .NET 4.8 Framework Extended (included)

and requirements Crystal Reports 13.01 runtime (included)

Internet Explorer 8 or higher

4.2.2 Distribution of the Vision Air Manager Network

The installation of the Vision Air Manager can be distributed in 2 different
manners.

ﬂ Metrohm recommends to distribute the Vision Air Manager Net-
work via e-Mail.

Distribution via e-mail

1 Go to Users » Summary.
2 Fillin the Contact Information and Account Information.

3 Click on Send link info » OK to send an installation link to the
new user.
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Contact Information
First name

Last e

Emal:
Office phare:

Call phane:

Account Information
User IC:
Disabled:

Lexked:

Manual installation

1 Toinstall an additional version of Vision Air Manager Network, go to
the folder where the Vision Air instance has been installed to the pc.
The additional version of Vision Air Manager Network will be instal-
led in this folder.

The default folder is "C:\Program Files (x86)\Metrohm\Vision Air
Server\VisionAin\VisionAirManager".

2 Copy the installation file "setup.exe" to the PC where you want to
install the additional Vision Air Manager Network version.

3 Start the installation file "setup.exe" on the respective PC.

4.3 Vision Air Routine

4.3.1 System requirements
Table 15  Vision Air

Operating system Windows 7 SP1 (64 bit)
Windows 10 (64 bit)

Operating System Language must be English
(during installation only)

CPU Dual core 2.8 GHz processor
Memory (RAM) 4 GB
HDD 20 GB free disk space

NTFS file system
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Display 1024x768 resolution, 32 bit color display
NIC 1x 100 Mbit Ethernet
Drives DVD drive

1 free USB drive

Additional software | PDF Reader software

and requirements Support for IP protocol version 4

Additional system Since the Vision Air Manager is installed at the
requirements same time, the system requirements for Vision
Air Manager must be met (see "System require-
ments", chapter 4.2.1, page 116).

Firewall

Configure all firewalls and VPN clients to allow UDP broadcasts on port
61525 on the interface that is connected to the instrument. Otherwise,
Vision Air might be unable to connect to the instrument.

You must be logged in on the PC as an administrator when you
install Vision Air.

H Power options in the PC should not be set to automatic sleep mode
or hibernation. If the PC goes into sleep mode or hibernation mode,
it will lose connection to the instrument and a restart of both,
Vision Air and the instrument, is then required.

[} Vision Air supports all XDS instruments and DS2500 instruments.

Pre-installation

Make sure that you are logged into the PC with administrator rights.

Make sure that Windows is up to date, including the Microsoft .Net
Framework.

Make sure that no Microsoft SQL Server 2019 is installed.

Windows language settings

Set the language to English using the following procedure:

1 Open the Windows language settings, for example, as follows:

= In the Windows search box on the taskbar, type language set-
tings.
= Select Language settings.
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2 Make sure that the Windows display language is English (United

States) or English (United Kingdom).

Language

Languages

‘Windows display language

English (United States)

language.

3 Click on Administrative language settings.

Related settings

Date, time, & regional formatting

‘Windows features like Settings and File Explorer will appear in this

A Add a Windows display language with Local Experience Packs

Use Local Experience Packs to change the language Windows uses for
navigation, menus, messages, settings, and help topics.

I Administrative language settings

Spelling, typing. & keyboard settings

The Region window opens.

4 Inthe tab Administrative, click on Copy settings...

Formats  Administrative

Welcome screen and new user accounts

View and copy your international settings to the welcome screen, system
accounts and new user accounts,

5 Copy the current settings to the system accounts by activating the

check box Welcome screen and system accounts.
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& -
@ Welcome screen and new user accounts settings

The settings for the current user, welcome screen (system accounts) and new
user accounts are displayed below.

Current user

Display language: English (United States)
Input language: English (United States) - US
Format: English (United States)
Location: Switzerland

Welcome screen

Display language: English (United States)
Input language: English (United States) - US
Format: English (United States)
Location: Switzerland

Mew user accounts

Display language: Deutsch

Input language: German (Switzerland) - Swiss German
Format: German (Switzerland)

Location: Switzerland

Copy your current settings to:

[ Welcome screen and system accounts

[ Mew user accounts

Confirm with [OK]. A Windows restart is required: [Restart now].

43.3 Installation of Vision Air
To install Vision Air, shut down all other programs on the computer.

Make sure that you are logged into the PC with administrator rights.

H There are 3 different installers:
= Installer for XDS instruments
= Installer for DS2500 Solid Analyzer
= Installer for DS2500 Liquid Analyzer

Choose the installer according to the instrument you are connect-
ing.

Proceed as follows:

1 Insert the installation medium with the Vision Air installer and dou-
ble-click on the installer for DS2500 Solid Analyzer, DS2500 Liquid
Analyzer or XDS instruments.

2 Before Vision Air is installed, the program checks whether there are
any necessary software components missing on the PC.
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The first time Vision Air is installed on a PC, all these software com-
ponents are installed one after the other. Follow the on-screen
instructions and click on [OK] when prompted. When re-installing
Vision Air at a later stage (for example when upgrading to later ver-
sions), most of these components needed are already installed and
these steps are skipped automatically during the installation.

Click on [Install].

Select the version of Vision Air you want to install according to the

following table.

Regulated environment?

Yes

Client/server setup?

No

Yes No
Vision Air Rou- Vision Air Vision Air / Vision Air
tine Network Pharma Network

Pharma

A client installa-
tion with pharma
features.

Installation of
Vision Air Rou-
tine.

A local installation
with pharma fea-
tures.

Installation of
Vision Air Routine
and Vision Air
Manager Local.

A local or client version
without pharma fea-
tures.

Installation of Vision Air
Routine and Vision Air
Manager Local.

The Vision Air
Server and the
Vision Air Man-
ager Network
must be installed
separetly. Refer to
the Vision Air
Network and
Server Pharma
tutorial
(8.105.8038EN).

Refer to the
Vision Air Local
Pharma tutorial
(8.105.8034EN).

For the local version,
refer to the Vision Air
Local tutorial
(8.105.8032EN).

For the client/server ver-
sion, the Vision Air
Server and the Vision Air
Manager Network must
be installed separately.
Refer to the Vision Air
Network and Server
tutorial (8.105.8036EN).
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ﬁ Vision Air (D52500 Series) Setup — x

2.0.0.264

Welcome to the Vision Air (DS2500
Vision Air Series) Setup Wizard

Select the version of Vision Air you want to install:

Vision Air f Vision Air Network
Vision Air | Vision Air Metwork:

Vision Air Pharma
ision Air Routine Network Pharma

L2 Metrohm

Badk Next Cancel

After selecting the version, click on [Next].
A license file is required later to activate the software after
installation.

E "Vision Air Complete" is a bundle version of Vision and Vision
Air; Vision needs to be installed with the separate installer.

5 Read and accept the license agreement. Click on [Niext].

6 For the DS2500 series, there is the option to install Vision Air with an
instrument simulator. Select [Install Vision Air for use with a
physical instrument] and click on [Install].

The selection Install Vision Air with an instrument simula-
tor is only for software demonstration and training purposes
and should not be installed on customer PCs.

7 Click on [Install] to begin the the installation.

g A text confirms the successful installation. Click on [Finish].

Installation log files can be found in the temp folder of your operat-
ing system. Open Windows Explorer and type in [%otemp%o]. In this
folder you will find a file named 'Vision_Air_DATE_TIME.txt".

9 After the installation, 2 new icons are created on the desktop.

= Vision Air Routine for access to the routine application part of
Vision Air.
= Vision Air Manager for access to the managing part of Vision Air.

10 !f desired, the Windows language can be changed again.
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4.3.4 Installation of the Unscrambler Prediction Classification Engine

The Unscrambler Prediction Classification Engine is a plug-in that allows to
use the third-party software Unscrambler in Vision Air.

Proceed as follows to install the Unscrambler Prediction Classification
Engine:

Vision Air must already be installed on your computer.

=Y

N

w

Double-click on the file setup.exe.

Click on [Execute].

The installation wizard opens.
Follow the instructions of the installation wizard.

In the Personal Information window, enter the following informa-
tion.

= Name

= Company

= Activation Key for Prediction Engine

» Activation Key for Classification Engine

ﬁ Unscrambler® X Engine 10.4.1 Setup X

Personal Information e

Brng oofa Yo Me
Please spedfy your name and the company, then dick Next.

MName:
|<aqa Sahl

Company:
Metrohm
Activation Key for Prediction Engine:

MLLPKCPRLL M

Activation Key for Classification Engine:
rsernTrveA S

o [ ] | oo

The scope of delivery for Vision Air includes a license CD. Find your
activation keys in the License Certificate.pdf file on the license CD.

The wizard continues.

After installing the Unscrambler Prediction Classification Engine, go
to C » CAMO Software » Unscrambler X Engine 10.4.1.

Copy the following files:
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= camoengine.dll
= olucx.sys
= olupx.sys

6 Go to C» Program Files (x86) » Metrohm » Vision Air
(DS2500 Series) or Vision Air (XDS Series). Depending on your
installation, you have either the folder Vision Air (DS2500 Series),
Vision Air (XDS Series) or both.

Insert the files that you copied in step 5 in your Vision Air folder.

The installation is complete.
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5 Start-up

5.1 Configuration

6 configuration steps need to be carried out before using Vision Air Net-
work with the Vision Air Server for quality control.

Calibration of the instrument.

Connecting the instrument to Vision Air Routine.

Register the user and instruments to the Vision Air Server.

Import of Vision Air licenses.

Importing or creating operating procedures.

Adding operating procedures to an instrument group and updating
instruments.

oA WN =

5.2 Calibration of the instrument

XDS instruments

Make sure your instrument is calibrated according to Vision Tutorial —
Instrument Calibration (81058054EN). Use either Vision or Vision Air
Setup for the instrument calibration. Vision Air Setup can be found on the
Vision Air installation DVD and needs to be installed manually.

DS2500 instruments
Calibrate the instrument with Vision Air instrument calibration.

To calibrate the DS2500 Solid Analyzer, see Calibrating the instrument in
Vision Air Routine, page 79.

To calibrate the DS2500 Liquid Analyzer, see Calibrating the instrument in
Vision Air Routine, page 83.

Before starting the instrument calibration, connect the instrument to
Vision Air Routine (see "Connecting the instrument to Vision Air Routine”,
chapter 5.3, page 126).
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5.3 Connecting the instrument to Vision Air Routine

On first start-up of Vision Air Routine there are some specific tasks to
establish a connection to the instrument.

Start-up Vision Air Routine

1 Afterinstallation, double-click on Vision Air Routine program icon.

2 Enter the serial number of the analyzer. The serial number can be
found on the type plate of your analyzer. For the Metrohm DS2500
Analyzer, it contains of 8 digits, starting with “917xxxxx"; for the XDS
Analyzers, it contains of 8 digits of the format “xxxx-xxxx".

Serial Number
Enter the instrument serial number.

MNumber

Connect Close

L) Metrohm

Connecting to instrument...

Connect to Vision Air Server

1 Go to section Tools.

2 Click on [Settings] and make sure the Vision Air Sync tab is
opened.

3 Click on [Edit] to enter the network properties dialog window.
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4 Network properties

Network

MName: IV\S\GHAIF

Vision Air Server

Address:

Port: 8007

Data upload settings

Upload sample data

Upload troubleshosting info

“ e

Fill in the needed server details and click [Test Connection].

If you do not know your server details, you will find the necessary
data within the Config Tool of Vision Air Server.

A window will open and confirm the successful connection.
5 Click on [OK] to finish the server configuration.
Synchronize with Vision Air Server
A connection to Vision Air Server must be configured first.
1 Go to section Tools.
2 Click on [Vision Air Synchronization].

3 Click on [Synchronize].
A successful synchronization is confirmed with a dialog window.

An information is displayed. It says that the registration in the Vision
Air Manager Network is required.
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5.4 Register the user and instruments to the Vision Air
Server

Create a network

Double-click on the Vision Air Manager Network program icon.

-

2 Enter your ID and password to log in.
For the first login, use the following user ID and password:

E User Name: admin
Password: a

3 Enter a new password after the first login.
4 Go to Instruments section.

5 Right-click anyhwere into the structure window and click on [New
Network].

Vision Air Manager I
{VISIONAIR)

File Edit View Report Help

sl
L LY
=y
g

%] Save 3 Revert

Instruments §e

& Mew network

A new network has been created.

6 Right-click on the newly created network and click on [Properties].



E Network Properties

Surveillance | Report Templates | Standardisation Groups | Data Cleanup | Security

General network settings
Name: New network

Description:

==

Apply.

Start-up

7 Enter the name and a description of the network in the Summary

tab.

g Confirm the entries with [OK].

Assign instrument types

1 Go to Instruments section.

2 Right-click on the desired network and click on [Assign instrument

types...].

A context menu opens.

Assign instrument type to the network

Name Description |
NIRS DS2500 NIRS DS2500 instrument Type
X0S XDS instrument family

Cancel
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Register the user and instruments to the Vision Air Server

3 Select the desired instrument type and confirm with [OK].

E Multiple instruments types can be selected by keeping the
[Ctrl] key pressed down.

Vision Air Manager

File Edit View Report Help

i:l Save 9 Revert

Instruments 0

B NIRS D52500
XDS

The instrument types are displayed in the structure window as fol-
lows:

Create an instrument group
1 Go to Instruments section.

2 Right-click on an instrument type and click on [New group].

A context menu opens.

m Tnstrument Group Properties

ent Settings | Operating Procedures | Parameters | Sunveillance Limits | E-mail Reporting

MName: New instrument group
Instrumenttype: | NIRS DS2500

Authenticatec:

Software package: | No software package selected

Description:

3 Enter a name under Name on the Summary tab and confirm with
[OK].



Vision Air Manager

{VISIOMAIR)

Start-up

File Edit View Report Help
i:l Save 9 Revert

Instruments

~ [B NIRS D52500
[EE' Laboratory
[EE' Production
@ xDs

0

The instrument groups are displayed in the structure window.

Assign an instrument

1 Go to Instruments section.

Vision Air Manager
(VISIONAIR)

salin,
L]
LL L L]

File Edit Wiew Report Help
(5] save S Revert

Instruments 0
v B vision Air

1. Unassigned Instruments
(B NIRS DS2500

The instrument must be connected to the network in Vision Air Routine
(see "Connecting the instrument to Vision Air Routine", chapter 5.3, page
126).

Open the entry Unassigned instruments in the structure window.

on [Register...].

3 Right-click on an unassigned instrument in the data window and click
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[ instrument registration

Registration
Name: NIRS DS2500

Serial number: 1503133742

Choose existing instrument group:

v &K c
v B 1scH m
v BF Lcas
v & mBES
r BF oL
» BF RTH
B 1618
+ B The Chemical Company - Practice 2
+ & The Chemicsl Company 1
+ & The Chemicsl Company 2
+ & The Chemicsl Company 3
~ BT vision Air

[y
& Praduction -
Cancel

4 Select the desired network and instrument group and confirm with
[OK].

The new instrument is added to the selected instrument group.

5.5 Import of Vision Air licenses

ﬂ To conduct the next steps, Vision Air Routine needs a one time
connection with the instrument.

To add a license to an instrument, proceed as follows:
1 Double-click on the Vision Air Manager Network program icon.
2 Go to the Instruments tab in the navigation window.
3 Select the instrument you want to add a license to.
4 Select the Licenses tab in the work window.

5 Click on [Import]. Choose the file that was provided with the Vision
Air License CD. Click on [OK].

6 Click on [Save] in the toolbar.
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5.6 Operating procedures

After setting up the system, operating procedures need to be defined to
conduct measurements in Vision Air Routine.

An operating procedure consists of 1 or several prediction models, a
method and optional user-defined fields. Operating procedures are select-
able in Vision Air Routine to conduct an analysis.

Prediction models are algorithms that correlate NIR spectra to properties
of the sample, for example, water concentration. Each prediction model is
linked to 1 parameter profile.

Parameter profiles define the parameter to be analyzed in accordance with
the linked prediction model. For example, a parameter profile for a predic-
tion model to quantify the water content is water in %.

Methods describe the way how a measurement is conducted, for exam-
ple, number of repetitions or temperature.

The following chart illustrates the structure and the workflow to create full
functional operating procedures. It is explained in detail in the following
chapters:

Option 1) Option 2)

v

Figure 4  Workflow description for operating procedures
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5.7 Importing a complete configuration

Complete operating procedures that were created in Vision can be impor-
ted into Vision Air Manager. A complete configuration from a different
Vision Air installation that includes all operating procedures of the system
can also be imported.

To import a complete configuration of operating procedures, proceed as
follows:

Import instrument group configuration

1 Select Instruments tab in the navigation window.

2 Right-click on a network (&) .

Instruments jo

v E Vision Air
- NIRS DS2500
[ﬂ, Laboratory

New Network
Assign instrument types...
Import Licenses

Import instrument group configuration

Properties

3 Select the .xml-file in the dialog window and click on [Open].

5.8 Creating a complete configuration of operating pro-
cedures

Carry out the following actions to create a complete configuration of
operating procedures.

1. Import prediction models (see "Importing prediction models", chap-
ter 5.8.1, page 135).

2. Create methods (see "Creating methods", chapter 5.8.2, page 137).

3. Create user-defined fields (see "Creating user-defined fields", chapter
5.8.3, page 138).

4. Create and configure operating procedures (see "Creating and con-
figuring operating procedures”, chapter 5.8.4, page 139).
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5.8.1 Importing prediction models

Prediction models that were created in Vision, The Unscrambler or
PLS_Toolbox can be imported into Vision Air Manager as follows:

1 Click on [Prediction models] in the navigation window.

2 Select the instrument type where you want to add a prediction

model.

3 Right-click in the data window on the instrument type (NIRS DS2500
Liquid, NIRS DS2500 Solid or XDS) and select [Import prediction

models].

Vision Air Manager Network

VA (VisionAin)
File View Report Help

i [® Save ) Revert

If" Prediction models

—j'.-= Parameter Profiles

&' Qual Virtual Machine
P vision_model_ori_dsta_Metrohm_test_BIP_EMP_PLS

Prediction models & Name Type Instrument Gr
- E Demo Network | ‘B id_polyolefin_Max Distance Vision Identification
@ NIRS DS2500 ‘B Kappa number 0-35 Mia Visicn PLS
XDS Import prediction models... Vision Identification
» BF Metrohm Argentina Create calculated prediction model... Vision MLR
» E Wetrohm Asia-Pacifique Create user-entered prediction model... Visicn PLS
B Metrohm Austria Create placeholder prediction model... Vision PLS
» & Wetrohm Brasi B e MW W PEPLS Vision PLS
+ B Metrohm Germany ‘B pe_PEPowder_DENS_DENS_PEP_PLS Vision PLS
+ &F Metrohm HQ B PE_PP Water analysis Vision MLR
» E Metrohm Israel 2 pe_PP_MFI_MFI_PP_PLS Vision PLS
v B Metrohm ltalia & pet PET_DEG DEG PLS Vision PLS
v BF Metrohm Maxico B pet PET_IPA_IPA PLS Vision PLS
+ B Metrohm Middle East B pet PETIV_IV_PLS Vision PLS
+ BF Metrohm Netherlands & PP Conc Analysis Vision MLR
» E Wetrohrm Poland E pulp_Pulp_Applied_density_Applied_density PLS Vision PLS
n pulp_Pulp_Breaking_strength_Breaking_strength_PLS Vision PLS
r:‘ﬁ [— B pulp_Pulp_Buckling_strength_Buckling_strength PLS  Vision PLS
&' pulp_Pulp_Kappa_number Kappa_number_PLS Vision PLS
Operating Procedures H pulp_Pulp_Pulp_freeness_Pulp_freeness_PLS Vision PLS
ﬂ pulp_Pulp_Tensile_strength_Tensile_strength_PLS Vision PLS

Vision Qualification

Vision PLS

4 Select prediction model(s) to import and click on [OK].

The Import prediction models window opens.

5 Link the imported prediction(s) with parameter profile(s) by clicking

on [Change].
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[ i it e o x

[

Predict

cdel Information
Nom: cffeinegpd
breccton Mordel Iype: | Dualficaion
Versir: 1000

Part number o

Globl unique centier: | 28324¢22-0142-4036-baT-Gbebicleebid

oy e T | Tee=

o

The Link parameter profile to parameter window opens.

Select a parameter profile from the list and confirm with [OK] or cre-
ate a new parameter profile by clicking on [New].

If you selected a parameter profile, the import is complete.

If you clicked on [New], proceed with step 7.

Only perform this step if you want to create a new parameter profile.

Define a new parameter profile name, short name, parameter code

and unit. The unit can only be defined with quantitative prediction

models.

General information

Name: new parameter prafile

Short name: parameter

Parameter code: parameter

Data type: Double =
MNumber of decimals: 2

Force negative ta zero:

Display order: 100

Report sort order:

Unit; None 7
Created: 7/2/2015 9:34:30 AM

Modified: 7/2/2015 %:34:30 AM

Created by: Oliver Leipnitz

Madified by: Oliver Leipnitz

Description:

Go to the Prediction models section for a detailed description of the
individual functions (see "Prediction models section", chapter 3.1.6, page

28).
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Go to the Parameter profiles section for a detailed description of the
individual functions (see "Parameter profiles section”, chapter 3.1.7, page
31).

5.8.2 Creating methods
To create a new method, proceed as follows:

1 Go to the Methods section.
2 Select a network. Open the drop-down menu of the instrument type

where you want to add the method. Right-click on the gear icon next
to the instrument type to which you want to add the method.

iz Vision Air Manager Network ]

A%  (VisionAir20ReleasedPharma)

File View Report Help

|:| Save 9 Revert

Methods Name
2 &! ahag RingCup
v B Metrohm AG
~ [B MIRS DS2500

£ NIRS DS2500 Comman
» [@ xDs | New Method

3 Inthe Summary tab, enter the name and optionally a description.

Settnee

General information

Name: new Method
Sample handling:  $mall cup

Description:

4 Choose a suitable sample vessel that you want to use for your analy-
Sis.

5 Save the settings with the [Save] button in the toolbar.

Additional settings that are available for methods are described in the
methods section (see "Methods section”, chapter 3.1.8, page 33).
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Creating user-defined fields

User-defined fields provide additional information on samples and can be
added optionally.

To create user-defined fields, proceed as follows:
1 Go to the User-defined fields section.

2 Right-click in the structure window on the network and select New

user-defined field.

The new user-defined field is displayed in the data window.

e

General information

Name: New user-defined field
Data Type: | String

Description:

Allow only fixed/predefined UDF values
This UDF is mandstory for sample registration
Transfer/repeat UDF value from previous sample registration

Values for this UDF can be edited for individual instruments

Switch to the Summary tab and enter the name and a description.
The following settings are available:

When activating the check box Allow only fixed/predefined UDF
values (defined on the Values tab), only predefined values can be
selected during sample registration in Vision Air Routine.

If the check box This UDF is mandatory for sample registration
is checked, the user is not allowed to do a sample registration with-
out filling out this user-defined field.

By checking Transfer/repeat UDF value from previous sample
registration, the last user-defined field entry that was made during
sample registration in Vision Air Routine is reselected automatically
for the next sample registration. The user-defined field entry can
always be changed.

4 Switch to the Values tab.

5 Click on [Add value].
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e

Available Values

Value

¥ new value

Add Value Delete Value

The new value is displayed in the work window.

6 Enter a name for the new value and save it with the [Save] button.

Y Further values can be added or removed at any time.

5.8.4 Creating and configuring operating procedures
To create and configure an operating procedure, proceed as follows:

1 Click on [Operating procedures] in the navigation window.

2 Right-click in the structure window and click on [New operating
procedure].

The new operating procedure is created and displayed in the data
window.

3 Prediction models = Methods | User-defined fields = Limits

General information

MName: new Operating Procedure

Code:

Sample type:  Normal =

Type: Unknown =

lcon: -
Show all icons:

Created: 23.05.2018 11:04:42

Modified: 23.05.2018 11:04:42

Created by: System Administrator
Madified by: | System Administrator
Active:

Description:
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In the Summary tab, define the name of the operating procedure.

4 Link prediction models, methods and user-defined fields (optional) to
the operating procedure. To do so, proceed with the following pro-
cedures.

To link prediction models, proceed as follows:

1 Summary R latORnELE S Methods | User-defined fields | Limits

Linked Prediction Models: Prediction model options:  Flat list of prediction madels =

%‘ Prediction model| Type | Part number | Version Imported Description | | Add...

Remove

Switch to the Prediction models tab.

2 Click on [Add...].

The Link prediction model to operating procedure window
opens.
3 Select the desired prediction models and assign them with [OK].

E Multiple items can be selected by keeping the [CTRL] key
pressed down.

Summary |l Tl OEaLLE NN Methods | User-defined fields | Limits

Linked Prediction Models: Prediction model eptions:  Flat list of prediction madels =
%| Prediction modeI|Type | Part number |Versn:tn | Imported Description Add..
¥ fy caffeine User-Entered Predictio... 0 1.00 30.05.2018 08:11:43 T
move
‘dh gascline User-Entered Predictio... 0 1.00 30.05.2018 08:11:43
;m lactose User-Entered Predictio... 0 1.00 30.05.2018 08:11:43

The prediction models are displayed in the work window.

4 Save the settings with the [Save] button.

To link methods, proceed as follows:

1 Summary | Prediction models @ User-defined fields = Limits

Linked Methods:

Name Conflguratl'nn| Description | Add...

Remaove

Switch to the Methods tab.
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2 Click on [Add...].

The Link methods to operating procedure window opens.

3 Select the desired method and link it with [OK].

Summary = Prediction models W User-defined fields | Limits

Linked Methods:

Mame Configuration | Description | | Add...

Small Cup MIRS D52500 Common

The method is displayed in the work window.

4 Save the settings with the [Save] button.

Additional settings that are available for operating procedures are descri-
bed in the operating procedures section (see “"Operating procedures sec-
tion", chapter 3.1.5, page 24).

Linking user-defined fields is optional.

To link user-defined fields, proceed as follows:

1 Summary | Prediction medels | Methods | QUSSR ELELRIELEE  Limits

Linked User-Defined Fields:

Mame Description | Type | Add...

Remove

Switch to the User-defined fields tab.

2 Click on [Add...].

The Link user-defined field to operating procedure window
opens.

3 Select a user-defined field and link it with [OK].

Summary | Prediction medels | Methods | QUSSR ELELRIELEE  Limits

Linked User-Defined Fields:

Mame Description | Type | | Add...

Batch Number String

The user-defined field is displayed in the work window.
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To define limits for operating procedures, proceed as follows:
1 Open the Operating procedures section.

2 Summary = Prediction models = Methods = User-defined fields

Allow instrument specific Operating Procedure limits

Instrument Group Description Group specific limits
P b Allgroups Operating Procedure specific limits
b Laboratory

b Production

Qperating Procedure limits:

Prediction Model Parameter Profile Type Lower Action | Lower Warning  Target Upper Warning  Upper Action

4 Lactose Content  Absolute ~

Import. Export..

Switch to the Limits tab.
3 Select the desired operating procedure.

4 In the table in the Limits tab, fill in the following information:

= Lower intervention: Lower intervention limit
= Lower warning: Lower warning limit

» Target: Target value

= Upper warning: Upper warning limit

= Upper intervention: Upper intervention limit

5 Save the settings with the [Save] button.

5.8.5 Adding operating procedures to an instrument group and updat-
ing instruments

1 Open the Instruments section.

2 Right-click on the instrument group and select Properties.
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Start-up

ﬁ@: ::‘?xn:iirr}Manager Network |
File View Report Help
i [*] save 9 Revert
Instruments 0O | Name Chassis ID Serial Number
+ B Dema Network DS Finnland 36028844274992929 91753790
~ [@ MIRS D52500 DS Iran 36028831392620195 91737849
dhy Precalibration Group DS South Africa | 36028831392537477 91737777
fﬂ, Simulator Group Update instrument group... 3010-1647
+ [@ xDs Delete group 2010-1646
3 g Metrohm Argentina Export instrument group configuration
» BF Metrohm Asia-Pacifique Properties N
&l_' Metrohm Austria |' Lo’
Go to the Operating procedures tab. Click on [Add].
=1 Instrument Group Properties o

Summary | Instrument Settings Operatmg WY arameters | Surveillance Limits | E-mail Reporting

Linked operating procedures:

Name | sample Type | Path | Description | \! Add.. |
BMP Normal Flash BMP

Kappa 0-10 el Pulp & Paper femeve
Keppa0-36  Normal  Pulp & Paper

Kappa36-90  Nommal  Pulp & Paper

Kappa90-180  Normal  Pulp & Paper

PETanalysis  Nommal  Polymer Analysis

Polyolefin analysis Normal  Polymer Anlysis

Pupanalysis  Normal  Pulp & Paper

Cancel | Apply

Select the operating procedures that should be added to the selected

instrument group. Confirm with [OK].

H Operating procedures can also be linked with individual instru-

ments (see "Operating procedures section”, chapter 3.1.5,
page 24).

Right-click on the instrument group. Select Update instrument
group....

Select the instruments which should be updated.
Click on [OK].
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Creating a complete configuration of operating procedures

The status update session is displayed in the Configuration Change
section (see "Configuration change section”, chapter 3.1.11, page
38).

[} After synchronizing in Vision Air Routine, operating procedures
are available in Vision Air Routine. The status for the configura-
tion change has changed to completed.



Operation and control

6 Operation and control

6.1 Data acquisition

6.1.1 Selecting an operating procedure

To select an operating procedure, proceed as follows:

1 Open Vision Air Routine.

2 Ensure that you use the most recent operating procedure. To syn-

chronize with the server, go to the Tools section and click on Vision
Air Synchronization.

3 Click on the [Operating procedure] drop-down list.

£2. Metrohm

m =
NiRoystems |gmmmwmm.w Batch Number _Smal cup (sationany) |

u
te: 4/06/2018
ne: 83043 AM

®

4 Select the desired operating procedure.

Select Operating Procedure 7

- | FRoot / Vision Air

Check Sample

ﬂ The = button is available if operating procedure groups were
defined in Vision Air Manager.
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Creating reports in Vision Air Routine

6.1.2 Analyzing a sample

To analyze a sample, proceed as follows:

1 Click on the [Start] button.

The sample is analyzed. The progress indicator shows the progress of
the analysis.

‘

[} 'f sample registration information needs to be entered, a window
opens that asks for the missing information.

ﬂ If the Tools section is selected, the [Start] button is not active.

6.2 Creating reports in Vision Air Routine

To export and print reports in Vision Air Routine, proceed as follows:

1 Go to the Tools section.

2 Click on the menu item [Reports].

Reports 7

Instrument diagnostics (PDF)

Instrument group audit events 30 days (PDF)
Instrument aperating procedures (PDF)
Sample detail (PDF)

Sample list (landscape) (FDF)

Samples 24 Hours (C5V)

Samples 24 Hours Detailed (CSV)

Simple single sample (PDF)

Details

Origin: Vision Air Mananger
Report type: InstrumentOverview

The Reports window opens.

3 Select the desired report type and click on 1 of the following buttons:

= [Print]: Prints the report.

= [Viewl]: Displays the report.

= [Save]: Saves the report.

» [To USB]: Saves the report to a USB device.
= [Close]: Closes the window.



Operation and control

6.3 Data maintenance

Data can be backed up, restored and deleted. In addition, the capacity of
the hard disk and the database as well as the total number of measured
samples can be displayed.

To back up data, proceed as follows:

1 Click on [Data maintenance].

Data Maintenance ?

Hard disk: 80.52% used of total capacity 40.00 Gb
Database: 1.43% used of total capacity 7.91 Gb
Mormal samples: 86

Other samples: 0

MOTE: When database is 95% full, the instrument will not be able o measure anymaore

Back up the entire database
Restore old data Restore
Delete all data (including samples) older than Monday, April 20, 2015 Delete now

Close

The top of the dialog box displays the system memory status.
Hard disk: Memory size left for all applications on the PC.
Database: Memory size left in the database for Vision Air data.
Normal samples: Number of analyzed samples.

Other samples: Number of analyzed samples that do not belong to
the normal type e.g. check sample, check sample operating proce-
dures.

2 Click on [Backup].

Backup

Press 'Backup’ button to run manual backup.

The Backup window opens.

3 Click on [Backup].
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Data maintenance

Backup

Backup was successfully created.

State
Dane

Backup Close

The backup is created.

4 Click on [Close] after the backup has been completed.
The storage location is defined under Tools » Settings » Export

in Vision Air Routine (see "Tools section", chapter 3.2.6, page 59).

Backup files can be restored in Vision Air. Be aware that database restora-
tion overwrites the existing database. Be careful not to overwrite valuable
information.

To restore data, proceed as follows:
Preconditions:

» You are logged in on the PC as an administrator.
= Windows User Account Control (UAC) is turned off.

1 Click on [Data maintenance].

Data Maintenance ?

Hard disk: 80.52% used of total capacity 40.00 Gb
Database: 1.43% used of total capacity 7.91 Gb
Mormal samples: 86

Other samples: 0

MOTE: When database is 95% full, the instrument will not be able o measure anymaore

Back up the entire database
Restore old data Restore
Delete all data (including samples) older than Monday, April 20, 2015 Delete now

Close

2 Click on [Restorel].
3 Click on [Browse] and select the backup file that should be restored.

4 Click on [Data restore] to open the backup file that should be
restored.

If a power loss occures during database restoration, proceed as follows:

Preconditions:
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= You are logged in on the PC as an administrator.
= Windows User Account Control (UACQ) is turned off.

1 Open the installation folder. This is typically C: » Program Files
(x86) » Metrohm » <instrument name>.

2 Start ServiceRoutinesExecutor.

The Restore dialog window opens.

3 Inthe Restore dialog window, click on [Browse] to select the data-
base backup.

4 Click on Restore to start database restoring.

6.4 Data management

6.4.1 Surveillance
To monitor sample data, proceed as follows:

1 Go to the Surveillance section in Vision Air Manager or Vision Air
Manager Network.

2 Go to the Samples tab.

3 Define the filter options, e.g. only show samples that were measured
with a specific operating procedure.

4 Define the time period of the data.
5 Click on [Filter].

6 |fneeded, right-click on a sample and click on [Details...] to display
detailed sample data.

To monitor diagnostics, proceed as follows:
1 Go to the Surveillance section in Vision Air Manager.
2 Go to the Diagnostics tab.
3 Click on [Filter].

4 Double-click on a start-up test.
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Data management

5

Select the wavelength test. Click on data to view the results.

To monitor instrument events and user related events (login, logout, lock-

ing

4
5

6.4.2 Sample lists

of users etc.), proceed as follows:
Go to the Surveillance section in Vision Air Manager.
Go to the Events tab.
Define the filter options, e.g. only show errors.
Define the time period of the data.

Click on [Filter].

To create sample lists and sample list groups, proceed as follows:

-

Select the Sample lists section in the navigation window.

Right-click in the structure window and select [New sample list
group].

Right-click on the new sample list group and click on [Sample list]
to create a sample list.

Select the Samples tab and add filter settings to filter measurements
accordingly.

Multiple sample lists can be created with different filter settings to
conveniently manage large data sets and track conducted measure-
ments.

Sample lists are also used for slope/intercept correction (see "Slope/
intercept calculations", chapter 3.3.8, page 75).



Malfunctions and troubleshooting

7 Malfunctions and troubleshooting

7.1 Exporting log files
To export log files, proceed as follows:
1 Open Vision Air Routine.
2 Go to the Tools section.

3 Click on the [Export logs] menu item.

Export Logs ?

Comments

If exporting to USB memory device, please insert device now

D Include database backup (estimated size: 116 Mb)
Send logs to Vision Air

Target path: C\Metrohm\Logs

Collect Logs Close

The Export logs window opens.

4 f desired, enter comments regarding the export in the Comments
field and select the option Include database backup. The Send
logs to Vision Air option is only needed in a client/server setup.
Please refer to the tutorials for Vision Air Network Tutorials for
details.

5 Specify the target path and click on [Collect logs].
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Remote support

7.2 Remote support
With the Remote support functionality, a remote access can be set up

with an external program. This remote access enables Metrohm employ-
ees to access the instrument in case of an error or for maintenance.

H To use this functionality, a full version of the TeamViewer software
needs to be installed on the computer.

To set up the remote support, proceed as follows:
1 Open Vision Air Routine.
2 Go to the Tools section.

3 Click on the [Remote support] menu item.

Remote Support ?

Click button below to initiate a remote support session. This will
allow your support engineer to remote control and inspect the
instrument in cooperation with you.

Initiate Support Session Cancel

The Remote Support window opens.

4 Click on [Initiate support session].

F B
5] Metrohm QuickSupport Elilg

L) Metrohm
NIRSystems

Allow Remote Control E o )

Please tell your Metrohm support engineer the
following ID to connect to your desktop:

Ready to connecdt [secure cannection)

www, teamviewer. com Cancel




Malfunctions and troubleshooting

The TeamViewer software is started and the Metrohm QuickSup-
port window opens.

Tell the Metrohm employee the displayed ID and the password.

The Metrohm employee can now access your computer and will per-
form the remote support.

7.3 Settings for database and SQL Server

Move database and security

If you have an existing database, then make a backup. Restore that
backup on the target SQL Server instance.

Grant SQL Server “db_owner” rights for the user representing
machine where Vision Air Service is running.

Set the Vision Air database as default 1 for the user mentioned in
step 2.

Redirect Vision Air to use another SQL Server (on an
already installed system)

4

Stop Vision Air service.

Edit hosting.exe.config, set connectionString property to the correct
server.

Move the database (either backup and restore or detach, move and
attach).

Start Vision Air Service again.

If Vision Air fails to start, then check the logfiles located in Vision Air
installation folder, subfolder logs (like C:\Program Files (x86)\IMetrohm
\Vision Air\VISIONAIR\VISIONAIR\Logs). Start with the newest host-
ing.exe-??.e2e and possibly also SchemaManagement-??.e2e.

If you are trying to run an old (older than 1.0) Vision Air host with a
remote database, you need to copy the CLR assembly to the PC where
SQL Server is installed (see the next paragraph).

If you have problems with MSDTC (it is mentioned in exception text in
server logs), try enabling Allow Inbound and Allow Outbound on
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Troubleshooting

7.4

Problem

Vision Air does not
start.

both, SQL and application servers (see "Remote SQL Server configuration”,

chapter 4.1.4, page 97).

Troubleshooting

The following table helps with troubleshooting for Vision Air Routine and

Vision Air Manager Local.

Cause

On the Vision Air Routine
PC, the Windows language
is not set to English.

Vision Air Services are not
started after restarting the
PC.

During installation, no
database (XDS, DS2500
or DS2500L) was created
in the SQL Server Express
instance.

Remedy

Set the Windows language to English (see
"Pre-installation”, chapter 4.3.2, page 118).

Restart the Vision Air Services manually, e.g. as
follows: In the Windows search box on the
taskbar, type services, and then select Serv-
ices. 2 services must be started, the respective
names may begin with:

= Vision Air (XDS Series). ..

= Vision Air (DS2500 Series). ..

=« Vision Air (DS2500 L Series)...

If the Start and Stop commands are grayed
out, proceed as follows:

= Disable the Vision Air services via context
menu » Properties.

= Restart the computer.

= Backup the SQL database.

= Uninstall Vision Air.

= Uninstall the Microsoft SQL Server.

= Log on to the PC with full administrator
rights and install Vision Air.

Make sure that no SQL Server 2019 is on the
PC. Make sure you have full administrator
rights during the installation.



Problem

It takes a long time to
update the instrument
settings during the
startup of Vision Air
Routine.

Cause

If a turkish operating sys-
tem is used, the collation
settings defined during the
SQL Server installation will
not fit the requirements.

VPN client

Malfunctions and troubleshooting

Remedy

2 remedies are available:

= Uninstall the Microsoft SQL Server. Install
the same Microsoft SQL Server version
manually and change the collation settings
to English during the installation process.

= Alternatively, change the Windows lan-
guage to English (see "Pre-installation”,
chapter 4.3.2, page 118).

Uninstall CheckPoint EndPointSecurity that is
part of the VPN client.
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8 Accessories

Up-to-date information on the scope of delivery and on optional accesso-
ries can be found on the Metrohm website. Download this information as
follows:

Downloading the accessories list

1 Go to https://www.metrohm.com.

2 Enter the article number of the product (e.g. 2.1001.0010) into the
search field.

The search result is displayed.

3 Click on the product.

Detailed information regarding the product is shown on various tabs.

4 On the Included parts tab, click the link to download the PDF.

The PDF file with the accessories data is loaded.

H Metrohm recommends downloading the accessories list from the
Internet and keeping it for reference purposes.
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